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Introduction

Dell™ UPS Management Software supports either an individual computer or network-connected
computers [including both local area networks (LANs) and the Internet].

The software monitors the UPS and safeguards computer systems from uncontrolled shutdowns due to
power failure. With the Dell UPS Management Software, you can monitor and configure the UPS on
any computer within the same LAN. One UPS can provide multiple computers in a network with
simultaneous power management, including system shutdown, saving application data, and shutdown of
the UPS when utility power fails.

Dell UPS Management Software Components

Dell UPS Management Software has three components:

* The Agent is the core component of the Dell UPS Management Software and runs in the
background as a system service. It communicates with the UPS, logs events, notifies users of
events, arranges actions according to the user's specifications, and initiates shutdown when
necessary. The Agent can be managed by the Monitor.

* The Monitor is the user interface application of the Dell UPS Management Software. Relying on the
Agent, it gathers real-time UPS information, UPS status, and server information, and allows the
user to tailor the UPS working parameters. The Monitor can run on any computer on the LAN or
on a standalone computer.

e The Tray lcon is the management tool of the Dell UPS Management Software, and it appears in the
status area of the system task bar. The Tray Icon is available only for the Microsoft® Windows®
platform.

The Tray Icon uses two different icons to display the current Agent status (see Table 1):

Table 1. Tray Icon

| *\ 10:48 Abd Agent is running,.
| K 10:49 A4 Agent is stopped.
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Right click the Tray Icon to display a shortcut menu (see Figure 1). Use the shortcut menu to start and
stop the Agent or Monitor.

Start Agent
Stop Agent
Start Momitor

Exit

Figure 1. Tray Icon Shortcut Menu

Figure 2 shows the relationships between the software components and the UPS.

UPS

< » Agent

Figure 2. Relationship Between Software Components and UPS
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Dell UPS Management Software Applications

Figure 3 shows the software application with a standalone computer.

Software UPS

Power Supply Cable
Communication Cable

Figure 3. Standalone Computer Application

Figure 4 shows the software application with a LAN.

Software UPS Software uPS

JLTID e

Power Supply Cable ==

Communication Cable
Network Cable

Figure 4. LAN Software Application
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Figure 5 shows the software application with the Internet.

Software UPS Software UPS

Software UPS

Software UPS

Power Supply Cable — -
Router
Communication Cable -

Network Cable

Figure 5. Internet Application
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Features

The Dell UPS Management Software has the following features:

10

Runs continuously to protect the equipment after the Agent starts.
Uninstalls easily and completely.

Provides a panoramic view of all information, including utility power, UPS, load, and battery status,
all in the same window.

Automatically searches and remotely monitors any Dell UPS on the LAN.,
Manually searches and remotely monitors any Dell UPS on the Internet.

Provides security protection with an administrator password. Only the system administrator has full
access; other users have only view access.

Protects data automatically by closing open applications and saving the related files.
Turns the UPS on and off, providing maximum protection for your computer system.
Initiates a UPS self-test.

Supports Simple Network Management Protocol (SNMP) monitoring.

Shuts down the network.

Logs data and events (including utility power, UPS, load, and battery status) so the system
administrator can perform daily system maintenance.

Provides flexible methods of notifying users of UPS status, including:
- Broadcasting messages to all users in the network.

- Sending messages to a pager.

- Sending messages by e-mail.

- Sending messages to a mobile phone with Short Message Service (SMS).
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Installation

System Requirements

A minimum of 128 MB of physical memory (256 MB is recommended)
A minimum of 160 MB of hard disk space

More than 256 colors and 800 x 600 resolution or above display is recommended

Administrator credentials (for Microsoft Windows Vista® and Windows 7 operating systems)

Superuser credentials for Linux® operating systems
TCP/IP communication protocol installed to support network management

An available communication port (RS-232 serial port or USB port)

Platforms supported by Dell UPS Management Software include:

Microsoft Windows Server® 2008, Standard Edition
Microsoft Windows Server 2008, Standard x64 Edition (includes Hyper-V™)
Microsoft Hyper-V Server 2008 R2

Microsoft Windows Storage Server 2008, Standard Edition
Microsoft Windows Server 2003 R2, Standard Edition
Microsoft Windows Server 2008 R2, Standard x64 Edition
Microsoft Windows Small Business Server 2003 R2
Microsoft Windows Small Business Server 2008

Red Hat® Enterprise Linux

Novell® SUSE® Linux Enterprise Server

Microsoft Windows XP® Professional

Microsoft Windows XP Home

Microsoft Windows Vista Home Premium

Microsoft Windows Vista Business

Microsoft Windows Vista Ultimate

Microsoft Windows 7 Professional x32, x64

Microsoft Windows 7 Ultimate

Ubuntu® Linux

Installation
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Installing the Software

This section includes installation instructions in a graphical user interface (GUI) environment and a
console environment.

Installing in a GUI Environment

To install the software in a GUI environment:

1 For a Microsoft Windows operating system, run setup.exe from the CD drive: \Windows directory
to start the installation program (see Figure 6).

%

zatup

Figure 6. Setup Icon

NOTE: In the Microsoft Windows Vista and Windows 7 operating systems, you are prompted to enter the
administrator account information.

For other operating systems, enter the command:
./setup.bin
or

setup console.bin (see Iigure 7).

= file: /mnt/edrom/Linux

11‘

InstallerData resource

setup. bin. lax

= >

Figure 7. setup.bin
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2 Sclect the language for the software and click OK (see Figure 8).

Flease selectthe languade during the installation:

‘|

Figure 8. Selecting the Language for Installation

3 Read the introduction and click Next (see Figure 9).

Yl Dell UPS Nanagement Software 01.09.0001 |Z||E|rzl

Introduction

& Introduction InstallArywhere will guide you through the installation of Dell UPS
o Management Software.
] ) ) _—
JRE 1.6.0will be installed in this computer.
]
r Iti= strongly recarmmended thatvou quit all programs befare
" cantinuing with this installation.

Click the Mext' button to proceed to the next screen. If you want to
change something on a previous screen, click the 'Previous' button.

You may cancel this installation at any time by clicking the 'Cancel’
hutton,

Installanywhere by Macrovision

Cancel Brevious

Figure 9. Introduction Window
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4  If there is a previously installed version of the Dell UPS Management Software, the software
prompts you to remove it. Click Yes to remove the software and continue with the installation
(see Figure 10).

Check Previous Verzion §|

'_:) A previous version has been installed. Are you sure you
want to remove it¥

Figure 10. Removing the Previous Software Version

5  The software provides an option to keep the previous software configuration parameters, such as
local UPS information, Network Management Card settings, shutdown parameters, and alarm
settings. Click Yes to keep the previous configuration file; otherwise, click No.

Save Configuration El

‘i) Would you like to keep the old configuration settings?

-t

Figure 11. Saving the Previous Configuration Parameters
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The software begins uninstalling the software (see Figure 12).

Dell UPS Nanagement Software F§|

1 ! Uninstalling...

%% %% %% %% %%

Figure 12. Uninstalling the Software

6 By default, the software installs to C:\Program Files\Del\UPS Management Software. Update the
location if needed and click Next (see Figure 13).

¥ Dell OPS Nanagement Software 0109 0001

Choose Install Folder

7 Introduction Where Would You Like to Install?

™ Choose Install Fo C:'Program Files'\DellWUPSManagementSoftware |
s Restore Default Folder ] [ Choose.. ]
| ]

| ]

| ]

Installamywhere by Macrovision

Figure 13. Choose Install Folder Window
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7 Sclect the shortcut folder and click Next (sce Figure 14).

] Dell UPS Nanagement Software 01.09.0001 |

[E&)

Choose Shortcut Folder

= .
Introducthn Where wauld you like ta create producticans®

™ Choose Install Fo
™ Choose Shortcut Folder
]
]
]

In & new Pragram Group: Dell LIPS Management Software
1 Inthe Start Menu
[] On the Desktop

1 Inthe Quick Launch Bar

Create lcans for All Users

Installamwhere by Macrovision

Previous ][ Mext

Figure 14. Choose Shortcut Folder Window
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8  Review the selected installation options. If the options are correct, click Install to begin the
installation (see Figure 15).

4 Dell UPS Management Software 01 090001

Pre-Installation Summary

™ Introguction Please Review the Following Before Continuing:
™ Choose InstaII.FU- Product Name:

™ Choose Shorteut Folde Del UPS Management Software

™ Pre-Installation Surnmary
| ]
]

Install Folder:
ChDocuments and Settings\eo97 99244y
Documentsikly ProjectsiDell Sy Rew 2

Java VM Installation Folder:
ChDocuments and Settings\c297 39244y
Documentsikdy ProjectstDell SV Rey 2Ajre

Disk Space Information (for Installation Target):
Fequired: 112,612 420 hytes
Available: 4,589,243 424 bytes

InstallAmniwhere by Macravision

[ Previous l| Install

Figure 15. Pre-Installation Summary Window
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The Installing window displays (sce Figure 16).

Y2 Dell UPS Nanagement Software 01 090001

Installing Dell UPS Management Software

i 6 Install Falter:
'™ Choose Shorteut Folder
" Pre-Instaliation Summary
 onstalling..

W iEEl Corlete

S = Installing... Java Runtime Environment

InstallAnywhere by Macrovision

o ;

Figure 16. Installing Window
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9  When the installation program is complete, click Done to exit the installer (see Figure 17).

Yl Dell UPS Nanagement Software 01.09 0001 r_ E”gl

Install Complete

™ Introduction Congratulations! Dell UPS Management Software has been
= Choose Ihstall Fol successiully installed to:

¢
CTCIeE SO HE U 0y C:Program FilesiDelllJPSManagementSafware
™ Pre-Installation Summary

= Installing... Press "Done” to guitthe installer.

A Install Complete

Installanywhere by Macrovision

Figure 17. Install Complete Window

If the software installed successfully, the Dell UPS Management Software application can be found in
All Programs from the Start menu (see Figure 18).

|#iStart |([@ ESE |

Figure 18. Dell UPS Management Software Application in the Start Menu
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Installing in a Console Environment

To install the software in a console environment:

1

To start the installation program, enter the directory appropriate for the system and enter the
command:

setup console.bin
Read the provided information and press Enter to continue the installation.

Review the selected installation options. If the options are correct, click Install to begin the
installation.

When the installation program is complete, click Done.
Reboot the system to activate the software.

The installation program stores the Dell UPS Management Software run environment variables in
/etc/profile.

Starting the Software

This section includes startup instructions for Microsoft Windows and Linux operating systems.

Software Startup in a Microsoft Windows Operating System

To start the software in a Microsoft Windows operating system:

1

Start the Agent using one of the following methods:
*  Set the Agent to start automatically at computer startup.

*  Seclect Start menu > All Programs > Dell UPS Management Software to start the Tray Icon
and Agent (see Figure 19).

All Programs ¢ !'"

4 ﬁ Dell UPS Management Software j

. Log OF E’] Shut Down ﬂ Uninstall Dell UPS Management Software
] —

|#iStart |2 €& |

Figure 19. Starting the Tray Icon and Agent
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Start the Monitor. Right click the Dell UPS Management Software Tray Icon and select Start
Monitor (sce Figure 20).

Stop Agent

tart Moniter

Exit

Figure 20. Starting the Monitor

3

For Microsoft Windows Vista, Windows 7, and Windows Server 2008 operating systems, complete
Steps 4 and 5.

Right click the Dell UPS Management Software Tray Icon and select Exit.
Restart the computer to restart the Dell UPS Management Software.

If you have administrator privileges, you can restart the Dell UPS Management Software without
restarting the computer:

e Tostart the Agent, select Start menu > Control Panel > Administrative tools > Services,
and find the service UPSMSmonitor. Right click UPSMSmonitor and select Start.

e Tostart the Tray Icon, select Start menu > All Programs > Dell UPS Management
Software.

Software Startup in a Linux Operation System

To start the software in a Linux operating system:

1

The Agent starts automatically at system boot. If not already started, from the /opt/UPS directory,
enter the command:

./agent start
Start the Monitor. From the /opt/UPS directory, enter the command:

./monitor
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Uninstalling the Software

This section includes uninstall instructions for Microsoft Windows and Linux operating systems.

Uninstalling in a Microsoft Windows Operating System

To uninstall the software in a Microsoft Windows operating system:
1 Exitall Dell UPS Management Software programs.

2 Stop the Agent. Right click the Dell UPS Management Software Tray Icon and select Stop Agent
(see Figure 21).

top Agent

Start Monitor

Exit

Figure 21. Stop Agent

3 Exit the software. Right click the Dell UPS Management Software Tray Icon and select Exit
(see Figure 22).

Start Agent

Start Monitor

Figure 22. Exit

4  Begin uninstalling the software one of the following ways:

e Select Start menu > All Programs > Dell UPS Management Software > Uninstall Dell
UPS Management Software (see Figure 23).
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SIS R e R

"|&E Dellups 4 H Cell UPS Management Software

Log Off E)] Shut Dowen

@start |3 EE ” |

Figure 23. Uninstall Dell UPS Management Software

*  Seclect Start menu > Control Panel > Add/Remove Program. Select the Dell UPS
Management Software and click Change/Remove (see Figure 24).

or Rer e Programs =10l x|
Currently installed programs and updates: ¥ sShow updates Sortby: |Nama vI
=
B Dell UP anageme 0
Change/Remove
€33 HHD Software Free Serial Port Monitor 3,31 Size 4.97MB

Figure 24. Add or Remove Programs
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5  The Uninstall Program window opens (see Figure 25). Click Uninstall to continue.

Y Tninstall Dell UP5S Nanagement Software

Uninstall Dell UPS Management Software

A Introduction Ahoutto uninstall...
< !

’ Dell UPS Management Software

Thig will remove features installed by InstallAmpwhere. il not
remove files and folders created after the installation.

Before uninstalling the soffware, please backup your configuration
using "Expoart Configuration”.

After installing the software, your settings can be restared using
“Impaort Configuration”.

Install&nywhere by Macrovision

Cancel

Figure 25. Uninstall Dell UPS Management Software Window
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The uninstalling process begins (see Figure 26).

¥ Dninstall Dell UPS Nanagement Software

Uninstall Dell UPS Management Software

a Introductiu_n Flease wait while Installhnywhere s uninstaller

. ; removes the follewing features. ..
M Uninstalling... g

" Preparing...
Files...
Shorcuts...
Launchanywhere
Falders...
Registry...

Uninstalling... NT Service: UPSMSmonitor

Install&mywhere by Macrovision

Cancel I [TIIT] [TLIILL] ]

Figure 26. Uninstall Progress
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6  After the Dell UPS Management Software uninstalls completely, click Done (see Figure 27).

¥ Dninstall Dell UPS Nanagement Software |Z||§|rzl

Uninstall Complete

M Introduction All iterns were successiully uninstalled.
“ Uninstalling...

™ Uninstall Complete

Install&mywhere by Macrovision

Figure 27. Uninstall Complete Window

Uninstalling in a Linux Operating System

To uninstall the software in a Linux operating system:

1 Stop the Agent. From the /opt/UPS directory, enter the command:
./agent stop

2 Open the Terminal and enter the /opt/UPS directory.

3  Enter the command:

./Uninstall

26 | Installation



About the Software

This chapter describes the Dell UPS Management Software window and how to set preferences for the

software.

The Dell UPS Management Software Window

Select Start Monitor from the Tray Icon or select Dell UPS Management Software from the program
list to open the Dell UPS Management Software window, which displays a list of all Agents within the

LAN.

The tree view on the left side of the window displays a hierarchical list of items, such as Root, network
names, SNMP, the Agents, the communication port, and the UPS models (see Figure 28). By clicking
an item, you can expand or collapse the associated list of sub-items.

== Dell UPS Nanagement Software — baocnwl56102131 —

System Logs UPS Tools Honitor

D<LL

SHMP Preferences Language

UPS MANAGEMENT SOFTWARE

Help

=4 Root From Bypass Command

B-gf LAN

-

227
49.4

W
Hz

Cell LIPS Rack Freguency

ateeeeSestany

On Baftery

[00:00:00

e CLENT

W oltage 2480 W
Capacity

a4 %
Time remaining | 3 h 47 m 25

5
IABM State Floating

Recent Events:

20090722 09:62:37 Input AC Undervoltage
200907722 09:60:52 AC Power Restored

Figure 28. Dell UPS Management Software Window
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Selecting one of the UPS models displays details about the UPS on the right side of the window
(see Figure 29).

The UPS status diagram is a graphical representation of the UPS power status. The diagram shows the
AC Line, UPS, Load, Battery, and Bypass (if the UPS is on bypass). The data boxes for both the UPS
and Load have multiple pages. Click the data table to go to the next page.

The UPS state displays at the top of the window.

The last two events display at the bottom of the window.

= Dell URS Nanagement Software — baocnwlB61DZ2131 —

System Logs UPS Tools Monitor SNMP  Preferences Language Help

DAL urs MANAGEMENT SOFTWARE

From Bypas: Command

Woltage 226 W
Freguency 499 Hz
Cin Battery
\ IDU:DU:DU

'gggggﬁggﬁgzg

o

hadel Waollage 2480

|
Dell UPS Rac 1
AE00W HY - Capacity 95 %
2a0y Time remaining |2 h48m4
+BUS VoIt 228 v BATTERY 5
-BUSYalt 0 W 959; IAEM State Floating

Recent Events:

20080722 08:63:37 Input AC Undernioltage
2009007022 03:60:52 AC Power Restored

WA

w
=
£
T

Figure 29. Data Boxes with Multiple Pages
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Setting Software Preferences

You can customize the window appearance, specify the date format, and select a local language.

Changing the Window Appearance

Select Background Image from the Preferences menu to change the appearance of the main window

(see Figure 30).

= Dell UPS5 Management Software — baocnwl56102131 —

hiodel Dell UPS Rac
o SEO0WY H -
230
o + BUS Volt| 230 W
e WAN -BUS Vol 0 i

e e SNMP

Background Image » = None

System Logs UPS Tools Monitor SHKNMP Erelerentes| Help

UPS MANAGEMENT SOF rmat ] Color
Advanced Settings Gradient
From Bypass Command Text
Grid
Yoltage 227 Picture
Fraquency 488 Hz
On Battery

[ [

‘Woltage 248.0 W
Capacity 94 %
Time remaining 3 h 47 m 11

5
IABM State Floating

Recent Events:

2009/07i22 08:63:37 Input AC Undervoltage
2009/07/22 08:60:62 AC Power Restored

Figure 30. Changing the Appearance
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You can select one of the following for the background of the main window:
e None: Default gray background.
¢ Color: Uniform color background.
e Gradient: One color from light to dark.
* Text: Repeating text.
¢ Grid: Repeating image.
e Picture: Single image.

For example (as shown in Figure 31), select Color to change the background from the default gray to
the color defined in the Advanced Settings.

You can customize your selection of the background (see “Changing Advanced Settings” on page 32).

= Dell UES Nanagement Software — baocnwl56102131 —

System Logs UPS Tools Monitor SNMP Ereterences| Help

Background Image » HNone

UPS MANAGEMENT SOF DateFormat 1 = Color
Advanced Settings Gradient

Fram Bypass Command Text
Grid
vollage 226 W Picture
Fraguency 498 Hz
On Battery
\ |DD:DD:DD
AC LINE I=—m—m—m— UPs = = = = = |KelXolI}
173
Todel Dell UFS Fack— Voltage 7480 W
SEO0W HY - Capacity 95 %
! a0y Time remaining |3 h 48 m 4
o g ~BUS Vol 228 WV BATTER s
o WAN SBUS vl 0 Y 90 IABM State Floating
&-Re SNMP
Recent Events:
20090722 026237 Input AC Undenroltage
200907722 09:50:52 AC Power Restored

Figure 31. Changing the Background Color
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Changing the Date Format

Select Date Format from the Preferences menu to change the date format. The date options are:
Year/Month/Date, Month/Date/Year, or Date/Month/Year (sce Figure 32).

= Dell UPS NManagement Software — baocnwl56102131 —

System Logs UPS Tools hMonitor SKMP Ereterences| Help

Background Image »

ML UPS MANAGEMENT SOF DateFormat ¥ = YYMMIDD

Advanced Settings MMIDDYY

From Bypass Cormrmand DDAMNYY 1058
174

groelfjeency igsg :z EE:[ZL?:MY Egﬁo E::Z
vy Corert 00 &

N L] |

-+

1+

aueaseEseeY

e I
Dol UPS Rack—

“Woltage 2480 W
SEO0 H - 1 Capacity 95 %
2304 Tirme remaining |3 h48m 1
+ BUS Vall | 228 V BAE";R"'
%

s
IAEIM State Floating

Recent Events:

2009007422 09:53:37 Input AC Undervaltage
200900722 09:60:62 AC Power Restored

Figure 32. Changing the Date Format
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Changing Advanced Settings

Select Advanced Settings from the Preferences menu. The Advanced Settings window opens
(see Figure 33).

Advanced Settings fgl

General | Background Image|

General Text Color ‘Warning Text Color
R | 251 [[OLMC) TestTes | | R € #1258 [T TestTes
G (=01 L_JTestTes| | | G€| ([0 L) TestTes
B (51 LI Nreares | |B €] 30 UL TectTesd
Font

: EETRCEY.
Al ¥ haa, *3al

= EETIRGCET

= i

(oo ]

ok | Coanel ) Apply

Figure 33. Advanced Settings Window — General Tab
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Use the Advanced Settings window to change the appearance of the interface text and customize the

selected background image.

On the Advanced Settings — General tab view, you can change the color of the regular text and the
warning text. You can also change the font and text size from the Font lists (see Figure 33).

On the Advanced Settings — Background Image tab view, you can select and customize the image

background.

NOTE: To add pictures to the Picture drop-down list box, paste the image file in the images folder. The default

folder location is C:\Program Files\Dell UPS SWA\images.

% NOTE: Clicking the Default button returns the parameters to the default values.

Advanced Settings

| General| Backaround Image i
| ) Mone
R (328 |
@ Colar G| o [0
B4l »o LU
REE @0 LN &> CT CA
. Gl S0 | )| Ce CN Cv
| O Gradient B< (> zss IO cl CN
I '_- ; T s T = s
' Re¢ s(2s6 000 | avementSoftware|
O Text s o O e 1S [100]3
B¢ less [LIOLY [ Background
Rl (0 OO0 Offset [0 |-
O Grid Gl =0 L1 L) 20 J& [s0 12
Bl o LI [ Background
icluuds.jpg vg: L |
) Picture 396 144
Default |
Cox | Coancel ) [zmoy

Figure 34. Advanced Settings Window — Background Image Tab
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Changing Languages

To change the language of the interface display text, select the Language menu and then one of the
languages: English, Traditional Chinese, Simplified Chinese, German, French, Spanish, Russian,
Japanese, or Korean (sce Figure 35).

= Dell UPS Nanagement Software — baocnwl56102131 —

Systemn Logs UPS Tools Monitor SNMP  Preferences Languaue|

0O English

& Chinese(Traditional)
® Chinese(Simplified)
& German

® Erench

® Spanish
@ Russian
¥ Japanese
® Korean

e LN

Woltage 2480 W
Capacity g
Time remaining |2 h 47 m 20

v WAN M
|+ l.;» SNMP IABM State Floating

Recent Events:

200907022 09:53:37 Input AC Undervoltage
2O009/07/22 09:50:52 AC Power Restared

Figure 35. Selecting the Language for the Interface
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Configuring the Software

% NOTE: You must log in as administrator through the System menu to change any settings or the settings will not

be saved or implemented.

This chapter explains how to:

Auto-search for a UPS
Modify the password
View and set up the Event Log and Data Log

Contfigure actions for events, such as broadcasting a message, e-mailing a message, sending a text
message, or sending a page

Reset the Dell UPS sensor values

Control the UPS load segments

Rename the UPS model

Contfigure shutdown parameters

Set the UPS warranty period

Perform and schedule a UPS self-test

Perform and schedule a UPS on/off task

Remotely monitor any Dell UPS within the same LAN or on the Internet
Reboot computers on the LAN

Export configuration parameters
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Auto-Searching the UPS

Click Auto Search UPS from the System menu to search for the UPS connected to the computer's serial
port (see Figure 36). The search result displays in the tree view (see Figure 37).

=u Dell OPS Hanagement Softw

Sy_stem| Logs UPS Tools

Modify Administrator Password
Auto Search UPS

Import Configuration...

Export Configuration...
E:it

Figure 36. System Menu

= Dell TPS Nanagement Software — baocnwlb6102131 —

System Logs UPS Tools Monitor SKHMP Preferences Language Help

UPS MANAGEMENT SOFTWARE 27

=4 Root
g% LAN
B oo 561
= F 1

Location

IF Address Alias Status =

B2 VIAN
B SHMP

w
o<

Figure 37. Search Results
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Clicking an item in the tree view displays the following information (see Figure 38):
e All computers in the LAN that are running the Dell UPS Management Software Agent.
¢ The UPS communication port.
e The model type of the UPS to which the Agent is connected.
* The current status of the selected Agent.

% NOTE: Select a UPS model to display details about the UPS (see Figure 29 on page 28).

= Dell UPS Nanagement Software — baocnwl56102131 —

System Logs UPS Tools Monitor SHMP Preferences Language Help

D@L | UPS MANAGEMENT SOFTWARE

Load

Lin

Alias hodel Status ~

= ¢ Root Location IP Address

=% LAN
- — ML
= 1561 T|LAM-=haocrw 56.. 17218127126 Dell UPS Rac... From Bypass Co.. 0%

oEE
F9antESewe

s VAN
Be SNMP

Figure 38. Details of Selected Tree View Item

% NOTE: The first time the Agent starts requires more time than subsequent startups to communicate with the
UPS. The software keeps a record of UPS information and, after the first startup, the software starts according
to the last record. If the COM port, USB port, UPS model, or IP address changes, click Auto Search UPS from
the System menu to retrieve the new UPS information.

For Linux platforms, the software cannot auto-detect the serial port devices. If the system has a serial
port not listed in the default setting table, you must add it manually. Table 2 shows the default serial
port device settings.

Table 2. Default Serial Port Device Settings

Platform Serial Port Device

Linux /dev/ttySO /dev/ttyS1
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To manually add a serial port:
1  Seclect COM Port Setting from the System menu.

The Communication Port Settings window opens (see Figure 39).

Communication Port 5ettings @

SOk Port List
fodewitty 0
folennithy 1
Add

QK | Cancel |

Figure 39. Communication Port Settings Window

2 Enter the serial port device setting and click Add.
3 Click OK to save and exit.

To remove a communication port, select the device name and click Remove.
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Modifying the Password

To modify the password:
1  Login as the administrator.

2 Sclect Act as Administrator from the System menu. Enter the administrator password and click
OK (sce Iigure 40).

4 NOTE: The default password is admin.

Administrator

Password: || |

oK ]| [ cancel ]|

Figure 40. Administrator Password

If the password is not correct, the system displays an error message (see Figure 41).

Dell UPS Management Software | x|

@ You cannot act as the Superuser.
The password you typed is not correct or the agent does not allow remote configuration.

Figure 41. Error Message
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3 Select Modity Administrator Password from the System menu. The Administrator Password
Settings window opens (see Figure 42).

Administrator Password Settings r5_<|

Canfirm Password: I:I

[ 0K ]‘ [ cancel ]‘

Figure 42. Administrator Password Settings Window

NOTE: Only a Superuser on a local machine can set the administrator password. If you are not a
Superuser, the Administrator window opens first, prompting you to log in as an administrator.

Enter a new password in the New Password field.

Reenter the new password in the Confirm Password ficld.

Click OK.

N o u s

If the password is not the same, an error message displays. Reenter the password in both fields and

click OK.
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Viewing the Event Log

The Event Log Viewer displays the UPS event history (see Figure 43).

You can view the Event Log one of the following ways:

* Select Event Log from the Logs menu.

e Click the _icon from the toolbar.

* Click the View Log button in the Event Log area of the Record Setting window (see Figure 45 on
page 43).

Event Log Record Mo: 1-16134
[EJCDATE JC_TME J[EVENTTYPE J(DELETE])
@ 200850325 09:33:51  |Agent Start
2009403/25 09:37:41  |Dell UPS Rack 42001 High Efficiency Online in USB Utility Mot Present

200910324 09:37:42  |Dell UPS Rack 4200W High Efficiency Online in USE Bypass Mot Available
2009503726 | 09:37:43  |Dell UPS Rack 42001y High Efficiency Online in USE Input AG Underyaltage
2009/03/28 | 09:37:44  |Dell UPS Rack 4200 High Efficiency Onling in USE Input Under/Over Frequency
200910324 09:37:45  |Dell UPS Rack 4200WW High Efficiency Online in USE Bypass OverlUnder Fregquency
2009503726 | 09:37:47  |Dell UPS Rack 42001y High Efficiency Online in USE AT Power Failure

200803725 08:38:08  Dell UPS Rack 42000 High Efficiency Cnline in USB AC Power Restored
200970326 | 10:32:14  |Dell UPS Rack 42000 High Efficiency Online in USE Utility Not Present

2009503125 10:32:159  |\Dell UPS Rack 4200W High Efficiency Online in USE Bypass Mot Available
2008325 | 10:3216  |Dell UPS Rack 42000 High Efficiency Online in USE Input AC Undenoltage
2009503728 | 10:32118  |Dell UPS Rack 42000y High Efficiency Onling in USE Input UnderOver Frequency
2009503728 | 10:32119  |Dell UPS Rack 42000y High Efficiency Online in USE Bypass OverlUnder Fregquency
200950324 10:32:20  |Dell UPS Rack 4200WW High Efficiency Online in USE AC Power Failure

2009503728 | 10:32:40  |Dell UPS Rack 42001y High Efficiency Online in USE AC Power Restored

ﬂext| I | Har | End ) | Purge | E3p0n| Q|039|

T T T T T

Figure 43. Event Log Viewer
Click the Next, Prev, Home, and End buttons to navigate to different pages. To remove selected Event

Log items, select the Delete check box for each item and click Delete. To delete all events, click Purge
All. To copy the log to a file, click Export.Click Close to exit the window.
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Viewing the Data Log
The Data Log Viewer displays UPS data records (sce Figure 44).

You can view the Data Log one of the following ways:

e Select Data Log from the Logs menu.

e Click the
* Click the View Log button in the Data Log area of the Record Setting window (sce Figure 45).

icon from the toolbar.

Fart: bl RS FRecord No: 1-156/388

[ DATE JC_TME )Pt J[ __hdodel i — Oy )| (OuT=y ) (BATT=Y] (IN-F ) [(LOAD] [CELETE)

| 2008/0328 09:34:53 | USB | Dell UPS Rack 4200W High Eficiency Online | 228 230 | 2200 | 498 | 0 ]
E05/05/ S 1335 6 WO PIRD (LRSS Bk 200 g EMGIEN Il SRR e s Sl R B - T IR e 0 0
2008/03/25 | 09:36:53 USB | Dell UPS Rack 42001 High Efficiency Online 228 | 230 | 2200 | 498 a ]
2009/03/25 09:37:52 USB | Dell UPS Rack 42001 High Efficiency Online 228 230 | 2200 | 498 ] [
2009/03/26 | 09:38:53 | USB | Dell UPS Rack 42000y High Efficiency Online | 228 | 230 | 2200 | 408 a |
2009/03/26 | 09:39:52 USB | Dell UPS Rack 42001 High Efficiency Online 228 | 230 | zeon | 498 0 ¥
2009/03/26 | 09:40:63 USB | Dell UPS Rack 4200W High Efficiency Online 228 | 230 | 2700 | 4a8 a ]
2009/03/25 09:41:54 USB | Dell UPS Rack 42001 High Efficiency Online 228 230 | 2200 | 498 ] [
2009/03/26 | 0942:54 | USB | Dell UPS Rack 42000 High Efficiency Online | 220 | 230 | 2200 | 498 a g
2008/03/25 | 09:43:83 USB | Dell UPS Rack 42000/ High Efficiency Online | 228 | 230 | 2200 | 49.8 o O
2009/03/26 | 09:44:53 USB | Dell UPS Rack 42001 High Efficiency Online 229 | 230 | 2200 | 498 a O
2008/03/25 09:45:54 USB | Dell UPS Rack 42001 High Efficiency Online 229 230 | 2200 | 498 0 ]
2009/03/26 | 094653 | USB | Dell UPS Rack 42000 High Efficiency Online | 228 | 230 | 2200 | 498 a ]
208/ 25 B A7 6 HoE Il UES Bkl 200 g EMEIER D nlHc SNERS e 5 SIRE ARSI 21 BRI 0 ol
2009/03/25 09:48:53 USB | Dell UPS Rack 42001 High Efficlency Online 229 230 | 2200 | 498 a ]
e | [Eng Delete | [Burg ‘

Figure 44. Data Log Viewer
Click the Next, Prev, Home, and End buttons to navigate to different pages. To remove selected Data

Log items, select the Delete check box for each item and click Delete. To delete all data, click Purge
All. To copy the log to a file, click Export. Click Close to exit the window.
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Setting Event and Data Log File Parameters

Use the Record Setting window to set the parameters for the log files. Select Record Setting from the
Logs menu. The Record Setting window opens (see Iigure 45).

Record Setting E|
EventLog

Max File Length | 600 | Row(s)

[ Wiew Log ]|[ Settings ]‘

Diata Log
Max File Length 10000 | Row(s)

Record Interval LB |2 sec(s)

e ] | e )

Figure 45. Record Setting Window

% NOTE: Clicking the Default button returns the parameters in this view to the default values. If the OK button is
disabled, the current Agent is read-only, and you cannot set up the parameters. You may log in as a Superuser
through the Act as Administrator menu.

Table 3 lists the log options and parameters.

Table 3. Log Options and Parameters

Parameter Unit Maximum Value Minimum Value Default Value
Maximum File Length (Event Log) Rows 10,000 20 600
Maximum File Length (Data Log) Rows 10,000 20 10,000
Record Interval Seconds 3,600 1 60

The View Log buttons open the Event Log or Data Log. See “Viewing the Event Log” on page 41 or
“Viewing the Data Log” on page 42 for more information.

The Settings button opens the Event Action window. See the following section, “Configuring Event
Actions,” for more information.
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Configuring Event Actions

Select Event Action from the UPS menu, or click the Fﬁ icon from the toolbar, or click the Settings
button in the Record Setting window. The Event Action window opens (sce Figure 46).

Event Action [E|

Ewent List

% |UPS Batte ry Low ~ Record
4% UPS Output Overload

6 AC Festore
6 Communication Established
& Aoent Start
6 Agent Stop
P Svstern to be shut down 3

< | 4

|, communication Lost P( Beep

il AC Fail Pop-Up warhing

iOn Bypass 5 i

@Baﬂer}r TestFailed = S

A0, Site Wiring Problermn __—

i‘\Battery Disconnected [ E-mail

iChargerFailure

@ Eypass Mot Availahle T—

i1 Fan Failure

Ak Sevice Battery
[[] send Page

Setting

[ 0K ]|[ Cancel |

Figure 46. Event Action Window

You can select which actions should be performed when specific events occur:

e Record — Select the events to be recorded in the Event Log and select the Record check box. All
events can be recorded in the Event Log.

e PC Beep - Sclect the events to initiate an audible beep on your computer and select the PC Beep
check box. Only these events can be configured: Communication Lost, On Bypass, AC Fail, UPS
Battery Low, and UPS Output Overload. The PC Beep feature is available only for Microsoft
Windows platforms.
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Pop-up warning — Select the events to open a message window on your computer and select the
Pop-up warning check box. Only these events can be configured: UPS Battery Low,
Communication Lost, Communication Established, On Bypass, AC Fail, AC Restore, System to be
shut down, System to be shut down by another Agent, and Warranty Period has expired. The
Pop-up Warning feature is available only for Microsoft Windows platforms.

Broadcast — Sclect the events to be broadcast to the configured users and select the Broadcast
check box. All events can be broadcast. Continue to “Broadcasting a Message” on page 46 to
complete the configuration.

E-mail — Select the events to send an e-mail to the configured recipients and select the E-Mail
check box. All events can be e-mailed. Continue to “Sending Event Messages by E-Mail” on
page 49 to complete the configuration.

Send SMS — Select the events to send a text message to the configured mobile phones and select
the Send SMS check box. Continue to “Sending Event Messages by Mobile Phone” on page 55 to
complete the configuration.

Send Page — Select the events to send a page to the configured pagers and select the Send Page
check box. Only these events can be configured: UPS Battery Low, UPS Hardware Failure, UPS
Input Power Failure, and UPS Output Overload. Continue to “Sending Event Messages by Pager”
on page 57 to complete the configuration.
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Broadcasting a Message

% NOTE: Broadcasting is available only on the Microsoft Windows platform versions that include Messenger
Service. Messenger Service is not included with Windows Vista, Windows 7, and Windows Server 2008. Users
must have Messenger Service enabled on their computer to receive broadcast messages.

Select Broadcast Setting from the Tools menu or click the Setting button for Broadcast in the Event
Action window. The Broadcast Message Settings window opens (see Figure 47).

Broadcast Message Settings f5__<|
Broadcast To
i All Users Add

F Damain User

Send Message

[] UPS Battery Low

[ UPS Output Overload

[] cammunication Last

[ &G Fail

[ On Eypass

[] Battery Test Failed

[] site wiiring Problerm

[ Battery Disconnected

[ Charger Failure

] Bypass Mot Available

[] Fan Failure

[ Service Battery

[ AC Restare

[ Communication Established
< >

| Cancel |

||

|£

Figure 47. Broadcast Message Settings Window
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The Broadcast To area of the window lists the users who can be selected to receive broadcast messages,
including all users, domain users, and specific users.

e All Users — Sends the message to all computers that are in the same network with the local Agent,

whether or not the computer is in the same domain.
Domain User — Sends the message only to all computers in the same domain with the local Agent.

Specific User — Sends the message only to one or a group of defined users, but no others.

To add a new user:

1 Click Add to open the Add Broadcast User window (see Iigure 48).

Add Broadcast Oser

Add Broadcast User

]

( K ]|[ Cancel ]|

Figure 48. Add Broadcast User Window

2 Enter the username that will receive messages and click OK.

The names of the added users are shown in the Broadcast To area of the window.
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To configure the broadcast settings (see Figure 49):

1
2
3

Select the user who will receive messages.

Select the events that will be sent to the user.

Click OK.

The settings are effective immediately.

Broadcast Message Settings

Send Message

Broadcast To
| All Users Add
L

X

UPS Battery Low
UPS Output Overload
[ communication Lost
Ol AcFail

[1 on Bypass

Battery Test Failed
[1 site Wiring Prablem
[] Battery Disconnectad
[] Charger Failure

] Bypass Mat Available
[ Fan Failure

[1 service Eattery

] AC Restare
Communication Estahlished
<

|

| £

8]:4 ‘ Cancel ‘

Figure 49. Broadcast Message Settings

To remove a user, select the username and click Remove.

% NOTE: The All Users and Domain User items cannot be deleted.
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Sending Event Messages by E-Mail
NOTE: To send e-mail messages when an event occurs, the computer with the Dell UPS Management Software
installed must be connected to the Internet.

Select E-mail Setting from the Tools menu or click the Setting button for E-mail in the Event Action
window. The E-Mail Settings window opens (see Figure 50).

E-mail Settings El
ShTR Server Setting

SMTP Server |EOHSME1 1.napa. ad.etn.com |
SMTF User 22015827 |
Meed Password Authentication

Password |"-"" |

Sender Infarmation

Mame |

Phone |

[] Send Daily E-mail at | H || |

Receiver E-mail Address

Susan_Xiagdell.com

Add

Send Message

UPS Battery Low ~

UPS Qutput Owerload b

Communication Lost

A Fail

On Bypass

Paotan: Tact Failad 2

< | >
QK. | Cancel |

Figure 50. E-Mail Settings Window
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To configure the e-mail settings:

1  Enter the SMTP server settings:

Parameter Description

SMTP Server Enter the IP address (IPv4 address or IPv6 address) of the SMTP mail server that
will be used to send e-mail to the selected users.

SMTP User Enter the SMTP mail server login name with the complete address format. For
example, yyy@test.com.cn

Password If a password is required for the SMTP server, select the check box and enter the
password for the account.
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2 Enter the sender name and telephone number.

3 Tosend a daily e-mail at a specific time, select the check box and enter the time of day in 24-hour
format (see Figure 51). The e-mail contains two attachments: the Event Log and Data Log files for
the preceding 24 hours.

E-mail Settings E|
SMTP Server Setting

SMTP Server [EQHSME11 napa.ad.etn.com |
SMTP User  |e2015827 |

MNeed Password Authentication

Password |""-" |

Sender Infarmation

MName | |

Phane | |

[7] Send Daily E-mailat (23 |58 |:|so |

S

Receiver E-mail Address

SendMessage

] UPS Battery Low

[ UPS Qutput Overload
] ©ommunication Last
] aC Fail

[] ©n Bypass
1 Pattar: Tact Failad
< | >

o | (canel |

[0l

|i<

Figure 51. Sender Information
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4  Seclect the Add button (see Figure 52). The Add Receiver E-mail Address window opens
(see Figure 53).

E-mail Settings [z
SMTP Server Setting

SMTP Senver |[ECQHSME11 napa.ad.etn.com
SMTP User 22016827

Meed Password Authentication

Fassword |uuu- |

Sender Infarmation

Mame |

Phane |

[] send Daily E-rail at; | 2 | : | £ | : |

Receiver E-mail Address

i
o=
=

Ik

F{emmre

Send Message

M |UPS Eattery Low

3

[ UPS Qutput Overload
1 communication Lost
[ &C Fail

[] On Bypass
M1 Pattare Taset Failad
<

3

| »

o« || Ccancel |

Figure 52. Add Button
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Add Eeceiver E-mail Address

X

E-mail Address |de|l_sewice@dell.com |

( 0K ]|[ Cancel ]|

Figure 53. Add Receiver E-mail Address Window

5  Enter the receiver's e-mail address and click OK to save and exit.

6  Dell reccommends testing the e-mail function by selecting the e-mail address and clicking the Test
button. The software sends a test e-mail to the specified recipient.

NOTE: You can select the event messages from the E-Mail Settings window or from the Event Action
window.

7 Verity that one or more recipient e-mail addresses are selected, and then select the event messages
to be sent by selecting the message check box (see Figure 54).
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E-mail Settings E
ShATP Server Setting

SMTP Server |[ECHSMBET1 napa.ad.etn.com
ShTP User 22015827

Meed Password Authentication

FPassword |"-"" |

Sender Information

Mame | |

Phane | |

[] 5end Daily E-mail at: | | g | | ; | ] |

Receiver E-mail Address

dell_serice@dell.com

Add

[FRemove_||

Send Message

LIPS Battery Lows ~
[] UPS Qutput Owerload F
Communication Lost

[ AC Fail

IE

M1 pattare Tact Failad

< I

ok | Ccama

|

Figure 54. E-Mail Recipient and Message Selection

If the selected event occurs, the software sends the e-mail to all of the selected addresses in the
Receiver E-Mail list.

8  Click OK to save and exit.

To remove a recipient, select the e-mail address and click Remove.
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Sending Event Messages by Mobile Phone

% NOTE: Sending local SMS text messages requires that the computer with the Dell UPS Management Software
must have at least one communication port that is connected to a GSM modem or mobile phone.

Select SMS Setting from the Tools menu or click the Setting button for Send SMS in the Event Action
window. The SMS Setting window opens (see Figure 55).

SES Setting X
Sender
Cam Port COm1 w
Baud Rate 9600 v
Locus Chinese Mainland v
Receiver

Sendhiessage

UFS Battery Low

LIPS Output Overload

Communication Lost

AT Fail

On Bypass

Battery Test Failed

Site Wiring Problem “

oooooo

QK ]| [ cancel ]|

Figure 55. SMS Setting Window
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To configure the SMS settings:

1 Select the communication port that is being used by a GSM modem or mobile phone
(see Figure 56).

2 Set the baud rate for the communication port.

3 Ifyou are located outside of Mainland China, select Other for Locus.

SES Setting X
Sender
Com Port COhdt v
Eaud Rate 9800
Locus Chinese Mainland w
Receier

[

13781019196 13781019196
A

Remaove

Test

Sendhessage

LUPS Battery Low
UPS Cutput Overload W
Cormunication Lost

ALC Fail

On Bypass

Battery Test Failed

|

BEROOE

O

Site Wiring Problem v

ok | [ cancel |

Figure 56. SMS Setting Window with Selections

4  In the Receiver list, enter up to five mobile telephone numbers to receive a text message. Enter
only numbers with no spaces, alphanumeric characters, or symbols.

5  Dell recommends testing the SMS function by selecting a telephone number and clicking the Test
button. The software sends a test text message to the specified recipient.

NOTE: You can select the event messages from the SMS Setting window or from the Event Action
window.
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6  Sclect the event messages to be sent by selecting the message check box. If the selected event
occurs, the software sends the message to all of the telephone numbers in the Receiver list.

7  Click OK to save and exit.

To remove a recipient, select the telephone number and click Remove.

Sending Event Messages by Pager

% NOTE: Sending a page when an event occurs requires that the computer with the Dell UPS Management
Software must have at least one communication port that is connected to a modem.

Select Pager Setting from the Tools menu or click the Setting button for Send Page in the Event Action
window. The Pager Setting window opens (see Figure 57).

Pager Setting &l
Modern Port | TR v
Access Mumber Wit 0 = sec
FPager Number I:I Wyait 0 = sec
[] Dialing I:l to external ling  WWait 118
[] Dialing after message
Send Event Code Event Mame

O 101 UPS Input Power Failure

O 102 UPS Battery Low

| 103 UPS Hardware Failure

| 104 UPS Output Overload

( 0K ]| [ Test ]| [ Cancal ]|

Figure 57. Pager Setting Window
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1  Enter the applicable pager settings:

Parameter Description
Modem Port Select the communication port that is being used by the modem.
Access Number Some pager services require a delay between dialing the access number and the

message code. The Access Number is the station number that the pager joined
(which can only be an auto station). The waiting time is the delay time between
dialing the paging station number and the pager number; the delay time is set by
the paging station. For example, the Liantong 192 auto station requires a one
second delay.

Pager Number Some pager services require a delay between dialing the pager number and the
message code. The Pager Number is the number of the pager that accepts the
communication. The wait time is the delay time between dialing the pager number
and the message code (paging message content); the delay time is set by the paging
station. For example, the Liantong 192 auto station requires a one second delay.

Dialing number to external ~ For an external line, dial a specified number and delay a specified time to access

line the external line. If the external line phone number cannot be dialed directly, add
the switch number in the Dialing to external line field. The wait time after dialing
can be set as needed, generally one second.

Dialing number after Some pager services require a specific number to end the message code.
message

2 Dell recommends testing the pager function by clicking the Test button. The software sends a test
page (000) to the specified recipient.

NOTE: You can select the event messages from the Pager Setting window or from the Event Action
window.

3 Seclect the Event Code check boxes for the event messages to be sent (see Figure 58). Only these
events can be configured: UPS Input Power Failure, UPS Battery Low, UPS Hardware Failure, and
UPS Output Overload.

If the selected event occurs, the software sends the event code to the pager. The event code
displays on the pager.
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4  Click OK to save and exit.

Pager Setting

Mocdem Port | EITTENNNNN v

x)

Access Number Wit 0 = et
Pager Number I:I Wyait 0 = sec
[] Dialing I:l to external line  VYwait sec
[] Dialing after message
Send Event Code Event Mame

O 101 UPS Input Power Failure

| 102 LIPS Battery Low

| 103 UPS Hardware Failure

O 104 UPS Qutput Overload

( QK ]| [ Test ]| [ Cancal ]|

Figure 58. Pager Setting Window
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Resetting the Dell UPS Sensor Values

Select UPS Control Parameters from the UPS menu. The UPS Control Parameters window opens
(see Figure 59).

% NOTE: If the UPS Control Commands from Serial Port setting is disabled, configuration and load control
commands are restricted to the LCD only. This setting must be enabled from the LCD before you can select UPS
Control Parameters.

OF5 Control Parameters §|

[]Reset Peak Consumption Wyatts

[[] Reset Curmulative Consumption Watts

[[] Reset Peak Headroom \Watts

[ 0K ]|[ Cancel ]|

Figure 59. UPS Control Parameters Window

To reset the sensor values:

1  Select the check box for the options to reset:
e Reset Peak Consumption Watts
e Reset Cumulative Consumption Watts
*  Reset Peak Headroom Watts

2 Click OK.

The sensor values clear, and the date and time stamp for the statistic resets to the current date and
time.
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Setting up UPS Load Segment Control

The Load Segment Control window contains parameters to control each UPS load segment. Select
Load Segment Control from the UPS menu to open the Load Segment Control window
(see Figure 60).

% NOTE: If the UPS Control Commands from Serial Port setting is disabled, configuration and load control
commands are restricted to the LCD only. This setting must be enabled from the LCD before you can select Load
Segment Control.

%]

Load Segment Control

Load Segmentl [1Apnply to All Load Segments

[Itdinimurm battery charge level | | %
[ Shutdown Timer (-1 to 32767 seconds) | | s
[ Startup Timer (-1 to 32767 seconds) | | s
[ tdanual Shutdown

Figure 60. Load Segment Control Window

The parameters include:

*  Minimum battery charge level: Shuts down the selected load segment when the battery capability
is below its set percentage value.

e Shutdown Timer: Shuts down the sclected load segment when the utility power fails for the
amount of time equal to the setting time. The value range is -1 to 32,767 seconds.

e Startup Timer: Starts up the load segment when the set timer expires after utility power is
restored. The value range is -1 to 32,767 seconds.

* Manual Shutdown: Shuts down the load segment immediately.

* Manual Startup: Starts the load segment immediately.
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To configure the load segment:

1  Select the load segment to configure, or select the check box for Apply to All Load Segments.
2 Set the shutdown and startup parameters.

3  Click OK to save and exit.

Renaming the UPS Model

Select UPS Alias Information from the UPS menu to open the UPS Alias Information window
(see Figure 61).

OES Alias Information ﬁ_(l

hiodel :

Rename UPS  |Dell UPS] |

ok | [ _cancal |

Figure 61. UPS Alias Information Window

% NOTE: If the Dell UPS Management Software automatically detects the UPS model, you cannot rename it.

Select the UPS Model from the drop-down menu. You can rename the UPS by selecting the Rename
UPS check box and entering an alias for the UPS name.
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Configuring Shutdown Parameters

Select Shutdown Parameter from the UPS menu or click the |ﬁ| icon from the toolbar to open the
Shutdown Settings window (see Figure 62).

X

Shutdown Settings
Shutdown Options

[CONt ~| | Dell UPS Rack 5600W Hy - 230 v |
[ Allow battery ta discharge for [0 Jmin o] se
[ Shut down when remaining battery time is helow I:I min I:I sec

[] Beain Shutdown Immediately if Battery Low

[1 System
Time needed far system shutdown min

Powered by Load Segmentl  #

[ Rermate Shutdown by Agent

[0 ] min shut down system
] Run Comrmand File before Shutdown

Shutdown File hax Execution Time I:I min

[Redundant UPS Input Setting]|

i

Shutdown Conditions

Shutdown Conditions Agents to be shut down

Bemaove

Shutdown Alarm Parameters

Shutdawn Alarm Interial 1 min

StartWarning before Scheduled Shutdown (10 min

ok [ caneer

Figure 62. Shutdown Settings Window

NOTE: The System checkbox is checked by default if software detects a UPS connected to the server through
RS-232 or USB.
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% NOTE: If the UPS Control Commands from Serial Port setting is disabled, configuration and load control
commands are restricted to the LCD only. A read-only access message displays when you click 0K
(see Figure 63). You must enable this setting from the LCD before you can apply changes to the Shutdown

Settings window.

Dell UES Nanagement Software

'E Dell VES Rack SBOOW HY - E30% in COML
L3

iz configured for Read Only operations. Flease enable “Control commands from serial port” under the UPS settings menu and try again.

Figure 63. UPS is Set to Read-Only Message

% NOTE: If the Agent is connected to more than one UPS, each UPS has its own shutdown conditions.

The shutdown parameters are:

Parameter

Description

Allow battery to discharge for

The time that the UPS battery is able to supply power when utility power
fails.

Shut down when remaining battery
time is below

When the remaining battery time falls below the specified time, the
output of the UPS turns off. The battery time range is 0 to 4320 minutes,
59 seconds. The default value is 2 minutes, 0 seconds.

Begin shutdown immediately if
Battery Low

When a Battery Low event occurs, the Agent shuts down the UPS
immediately; otherwise, the shutdown time is controlled by the battery
backup time.

System Shutdown

The system shuts down while the selected UPS is being turned off.

System Suspend

The system is suspended to disk during the shutdown sequence. This
function is available only on certain Microsoft Windows platforms, and
Hibernate Support must be enabled from the Control Panel (Control
Panel > Power Options > Hibernate).

Redundant UPS Input Setting

If there is a redundant UPS supplying power to the local Agent, you can
safely shut down the local Agent before all UPSs shutdown. See
“Redundant UPS Shutdown” on page 69 for more information.

Time needed for system shutdown

The time required to shut down the system, from the initiation of
shutdown until it is complete.

Powered by

The Load Segment that powers the computer.

Remote Shutdown by Agent

Allows another Agent to shut down the selected UPS.

XX min shut down system

After receiving the specified Agent's shutdown signal, shutdown is delayed
by XX minutes.
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Parameter Description

Run Command File before Before system shutdown, the Agent can initiate a command if this

Shutdown parameter is not zero. The Agent does not begin to shut down the system
until the "Execute file before system shutting down” ends.

Shutdown File Max Execution Before system shutdown, the time required to implement the shutdown

Time file.

Shutdown Conditions Displays the remote Agents to be shut down. You can add, modify, or

remove the remote Agents.

Shutdown Alarm Interval The number of minutes between each shutdown warning.
Start Warning before Scheduled The time in minutes before a scheduled shutdown when the Agent issues
Shutdown the first warning.

Remote Shutdown by Agent

To configure for shutdown by a remote Agent:

1  Select the Remote Shutdown by Agent check box and click Add.

2 Enter the IP address (IPv4 address or IPv6 address) or host name of the Agent.
3 Click OK to save and exit.

When the local Agent receives the specified Agent's shutdown signal, the system shuts down in the
specified delay time.
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Shutdown Remote Agents

To configure for shutting down remote Agents:
1  Click the Add button in the Shutdown Conditions area.

The Shutdown Remote Agents window opens (see Figure 64).

Shutdown Remote Agents §|

Shutdown Conditions

|COM1 | |Dell UPS Rack 56000 HY - 2300

(@) Shutdown Load Segmentt -

() On Battery 10 rmin

Agents to he shut down

17218127125

Add

Bemave

QK ]| [ Cancel ]‘

Figure 64. Shutdown Remote Agents Window

2 Sclect Shutdown or On Battery:

When the UPS of the Agent is going to shut down and Shutdown is selected, the software sends
the shutdown command to the remote computers at the IP addresses that are listed in the
Shutdown Remote Agents window.

When On Battery is sclected, the software sends the shutdown command to the remote
computers when the time of the UPS transfer to battery exceeds the specified time.

3 Select the Load Segment that powers the computer.

4  Enter the IP address (IPv4 address or [Pv6 address) or host name and then click Add for each
Agent to be shut down.

5 Click OK to save and exit.
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When the shutdown condition is satisfied, the Agent sends a shutdown signal to the selected remote
Agents.

You can view and set the shutdown condition of each UPS according to its actual status

(see Figure 65).

Shutdown Conditions

Shutdown Conditions Agents to be shut down A
COn1 Dell UPS Rack 8600W HYW - 2300 [Load Segment!] to be shut . 17218127124
< > Bemove

Figure 65. Shutdown Conditions on the Shutdown Settings Window
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Shutdown Devices Monitored by Network Management Card
To shut down devices monitored by the Network Management Card:

1

2

Select SNMP from the serial ports list (see Figure 66).

The UPS list displays the IP addresses for all of the devices monitored by the card.

Select one device to set the shutdown parameters.

% NOTE: The SNMP shutdown function is available only in the local Agent shutdown setting.

Shutdown Settings
Shutdown Options

= g

[ Allaw battery to discharge far

[] Shut down when remaining battg

BT

[1 Begin Shutdown Immediately it B3
[ 5ystem

Time needed far system shutdown
Powered by

[] Remate Shutdown by Agent

I:I min shut down system

[ Run Command File hefare Shutdawn

172.18.127.33

172.18.127.60
172.18.127.81
I T

w

Sec

Sec

X

Load Segment!  +

Shutdown File hax Execution Time

Shutdown Conditions

|_| rmin

Shutdown Conditions

Apgents to bhe shut down

Add

Remove

Shutdowt Alarm Parameters

Shutdowen Alarm Interral

StartWWarning before Scheduled Shutdown min

]| [ Cancel ]|

Figure 66. SNMP List
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Redundant UPS Shutdown

If there is a redundant UPS supplying power to the local Agent, you can safely shut down the local
Agent before all UPSs shut down. Figure 67 shows a redundant UPS configuration.

AC

Server powered from two redundant
power supplies

Figure 67. Redundant UPS Configuration

Click the Redundant UPS Input Setting button to list all of the UPS devices (see Figure 68). Select the
redundant UPS that has different shutdown conditions by selecting its check box. The system will not
shut down until all the conditions of all selected UPSs are met.

Eedundant UPS Input Setting |§|
Fedundant LIPS Input Group
[ comat Dell UPS Rack 42000 High
[ shrP 1721812771
[] sHrdP 17218127 66
[ srrp 1721812774
[ sHmap 1721812720
< | b
(o4 | Cancel |

Figure 68. Redundant UPS Input Group
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Entering the UPS Warranty Period

Select UPS Warranty Period Setting from the UPS menu to open the UPS Purchase Date Setting
window (see Iigure 69).

UPS Purchase Date Setting [5_<|
Fort UPS: \DELL UPS Rack 5600W High Efficiency Oniine HY - 230V + |
UPS Purchase Date  |2008  »| [1 »| [1 =

Battery Purchase Date  [2009 % |1 % |1

UPS Warranty Period 3 W | years

Battery Warranty Period |3 W | years

[] Remind user that warranty period expired on

I:I Days l:l every month.

[] Enahle Warranty Period warning

ok [_cance

Figure 69. UPS Purchase Date Setting Window

Enter the UPS Purchase Date, Battery Purchase Date, UPS Warranty Period, and the Battery
Warranty Period.
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You can also remind users of upcoming warranty expiration dates or that the warranty period has
expired.

To remind the user every month that the warranty has expired:

1  Seclect the Remind user that warranty period expired on check box (see Figure 70).

PS5 Purchase Date Setting E]
Port  |[EENEM v uPs: | Dell UPS Tower 500W HY v |
LUPS Purchase Date 2009 @ |1 B8 |1 e
Battery Purchase Date | 2003w |1 v | |1 |»
UPS Warranty Period 3 | years
Battery Warranty Period |3 | years

Remind user that warranty period expired on

o &
116 | Days 17:45:00 |7 every maonth. |
Enahle Warranty Period wearning

[ QK ]| [ Cancel ]1

Figure 70. Monthly Warranty Expiration Warning Settings Example

2 Type or select the day of the month in the Days box.
3 Type or select the time of day in the every month box.

4  Sclect the Enable Warranty Period warning check box.
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The message displays at the top of the of the UPS status diagram and a reoccurring monthly warning
message displays on the selected day and time (see Figure 71).

| = ¢ Root
B-g% LAN

Woltage
Fraguency a0.0 Hz

2012/11/16 17:45:01 Load 0 %
l " l Current 0.0 A
Dell UPS Tower SO0 HY in COMT warranty Power il Wy

LN period has expired. |

s N

o B suvp [ Woltage 260 W
SO0W HA :
+BUSValt |0 y Capacity 100 %
-BUSValt |0 i BATTERY Time remaining | 7h30mos
Timestamp 20081112 IEE% IABM Ctate Resting

Recent Events:
20091116 17:26:45 Agent Start

Figure 71. Warranty Expiration Warning Message

% NOTE: For a one-time warranty expiration message, do not select the Remind user that warranty period
expired on box (see Figure 72).

OPS Purchasze Date Setting

Port | R v | UPs: [Dell UPS Tower 500W HY ~ |
UPS Purchase Date (2009 v | (1 v v

Battery Purchase Date | 2008 | [1 v
LIPS Warranty Period .3 ! years

Battery \Warranty Feriod |3 | years
[ Remind user thatwarranty period expired an
Days [01:01:01 | ewery month

Enable Warranty Period warning

ok [ cance |

Figure 72. One-Time Warranty Expiration Warning Settings Example
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Testing the UPS

You can perform a UPS self-test immediately or schedule a UPS self-test.

Performing a UPS Self-Test Inmediately

Select Request Battery Test from the UPS menu to open the Request Battery Test window
(see Figure 73).

% NOTE: If the UPS Control Commands from Serial Port setting is disabled, configuration and load control

commands are restricted to the LCD only. This setting must be enabled from the LCD before you can select
Request Battery Test.

Request Battery Test §|

QK ]‘ [ Cancel ]|

Figure 73. UPS Self-Test Inmediately Window

Select the Self-Test option and click OK to start the UPS self-test.

Click Cancel Current UPS Self-Test from the UPS menu to cancel the self-test process immediately.
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Scheduling a UPS Self-Test

Select Battery Self-Test Schedule from the UPS menu to open the UPS Test Manager window
(see Figure 74). You can schedule a UPS self-test for one time only or on a monthly basis.

TES Tezst Nanager D_<|
Sun Mon Tue ‘ed Thu Fri Sat
: e A !
k4 9 10 11 12 13 14
15 16 17 12 19 20 21 Symbol
2 23 24 a3 286 7 28 & UPS Power OfF
& UPS Power On
& UPS Test
Task List
Type Date Start Time Cperate Delay Time RS
~
™
< | ¥
[ dd Test | [ boary | [ Remove |

Figure 74. UPS Test Manager Window

The UPS Test Manager window displays a calendar at the top and the task list at the bottom. All of the
UPS self-test and UPS on/off tasks are shown in the task list. The calendar displays a red dot for the UPS
power off action, a green dot for the UPS power on action, and a blue dot for the UPS self-test action.
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To schedule a UPS self-test:

1  Click Add Test to open the UPS Self-Test window (see Figure 75).

OPS Test Nanager

OES Self-Test

Once e

Start Date |2DDQ V”S V”S V|
Th
Start Time 18:34:56 | -
1 2 3 4 5 -
8 ? 1o 1 12| @ Self-Test
15 14 17 & 18 Selt-Test Until Battery Low
22 23 24 25 2 caltTast
29 30 31
Selectthe UPS to he tested
Cell UPS Rack 42000 Hj
Task List
Type Date Start Time
SelectAll
< > Purge Al |
<
Add Test )

Figure 75. UPS Self-Test Window

2 Sclect how often to perform the UPS self-test: Once or Monthly.

3  Select the start date and time for the UPS self-test.

% NOTE: The scheduled date and time cannot conflict with another scheduled UPS task.

4  Sclect the Self-Test option.
5  Seclect the UPS to test.
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6 Click OK to save and exit.

% NOTE: If the UPS Control Commands from Serial Port setting is disabled, configuration and load control
commands are restricted to the LCD only. A read-only access message displays when you click 0OK.
(see Figure 76). You must enable this setting from the LCD before you can apply changes to the UPS Self-Test
window.

Dell UPS Nanagement Software

'E Dell UERS Short Depth Rack 2T00W High Efficiency Online HV-230V in COM1

L] is configured for Read Only operations. Please ensble “Control commands from serial port” under the UPS settings menu and try again.

Figure 76. UPS is Set to Read-Only Message

The UPS Test Manager window displays the task with a blue dot on the scheduled day and lists
the detailed information in the task list (see Figure 77).

MBS Test Nanager
March v| |e008 :
Sun hdan Tue Wied Thu Fri Sat
1 2 3 4 " 5 8 7
(_cancel |
2 9 10 11 12 13 14
15 16 17 12 19 20 21 Symbal
22 23 24 a5 26 a7 22 & UPS Power Off
2 30 A @ UPS Power On
® UPS Test
Task List
Type Date Start Tirme Operate Delay Time RS
Once 2009/03/04 |11:24:22 Seli-Test Dell UPS RackTower 27 D00 ir #
b
4 | »
Add Test [ odity ]] Eemove ]

Figure 77. UPS Test Manager Window
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Changing a Scheduled UPS Self-Test
To modify a scheduled UPS self-test:

1  Select one of the UPS self-test tasks in the task list.
2 Click Modify and then update the schedule (see Figure 78).
3  Click OK to save and exit.

UPS Self-Test

OP5 Test Nanager
March v| [z008 :
- Start Date 2009
Sun Mon Tue inied Thu Fri Sat 3
Start Time 144331 |
1 2 3 4 - 5 [ 7 Q -
2 9 0 11 12 13 14 (®) Gelf-Test
15 18 17 12 19 20 21 Self-Test Until Battery Low
2 23 24 25 % 2 2 E— 10 |
il 30 il
Selectthe UPS to be tested
COM1 Dell UPS Rack 4200 Hi
Task List
Type Date Start Time Operate Delay Tim|
2 Selft-Test SelectAll
< [ > Purge All I
<
[ Agd Test ] < oriyy_> | ok || [ cancel ]|
Figure 78. Modify Task
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Removing a Scheduled UPS Self-Test
To remove a scheduled UPS self-test:

1
2

Select a UPS self-test from the task list.

Click Remove to cancel the task (see Figure 79).

OPS Test Hanager
March v| |2008 2
Sun on Tue Wed Thu Fri Sat
1 2 3 4 - 5 [} 7
2 9 10 11 12 13 14
15 16 17 12 19 20 21 Syrbal
22 23 24 25 26 7 22 & UPS Power Off
2 30 3 ® UPS Power On
® UPS Test
Task List
Celay Time LRSS

Date Start Time Cperate

1

[ Add Test )

Modify

J

{ Bemove

]

Figure 79. Remove Task
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Turning the UPS On/Off

You can remotely turn the UPS off and on using the Dell UPS Management Software.

Scheduling a UPS On/Off Task

Select UPS On/Off Schedule from the UPS menu to open the UPS On/Off Manager window
(see Figure 80). You can schedule a UPS On/Off task for one time only or on a weekly basis.

UPS On/Off Nanager 3
v| 2008 =
Wed Thu Fri Sat
1 2 3 4 5 fi 7
2 9 10 11 12 13 14
15 16 17 12 19 20 2 Syrmhal
n 23 24 25 26 27 22 & UPS Power OFf
& UPS Power On
& UPS Test
Task List
Type Date Start Time Operate Delay Time UFPS
o~
\)
< | >
Add UPS Oniof | [ oary || [ Remme ||

Figure 80. UPS On/0ff Manager Window

The UPS On/Off Manager window displays a calendar at the top and the task list at the bottom. All of
the UPS self-test and UPS on/off tasks are shown in the task list. The calendar displays a red dot for the
UPS power off action, a green dot for the UPS power on action, and a blue dot for the UPS self-test
action.
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To schedule a UPS On/Off task:

1

Click Add UPS On/Off to open the UPS On/Off window (see Figure 81).

UPS On/Off &
(g | |2009 UPS Schedule Of
S| GEE | e | e Power Off Once [2000 w4 ME v
1 4 =
12 13 14 15 Power On Once |2009 V||4 V”Z V|
19 E 21 2
2 27 % 2 EENE

Selectthe UPS to be turned off

Task List Dell UPS RackiTower 271
Type Date Start Time
SelectAll
¢ » Purge All |
<
<[ Add UPS oniott [ Moty | [ ok [ cancel ||

Figure 81. UPS On/Off Window

80

Select how often to perform the UPS On/Off task: Once or Weekly.
Select the start dates and times for the UPS On/Off tasks.
% NOTE: The scheduled date and time cannot conflict with another scheduled UPS task.

The UPS Power Off time range (from shutdown to next startup) is 1 to 9999 minutes (the
maximum time is 6 days, 22 hours, and 39 minutes). The range for the year is 2009-2035.

Select the UPS to turn off and on.
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5 Click OK to save and exit.

% NOTE: If the UPS Control Commands from Serial Port setting is disabled, configuration and load control
commands are restricted to the LCD only. A read-only access message displays when you click 0OK.
(see Figure 82). You must enable this setting from the LCD before you can apply changes to the UPS On/Off
window.

Dell UPS Nanagement Software

'E Dell UERS Short Depth Rack 2T00W High Efficiency Online HV-230V in COM1

L] is configured for Read Only operations. Please ensble “Control commands from serial port” under the UPS settings menu and try again.

Figure 82. UPS is Set to Read-Only Message

The UPS On/Off Manager window displays the task with a red or green dot on the scheduled day
and lists the detailed information in the task list (see Figure §83).

UPS On/Off Nanager 3
| April v| |2009 -
Sun han Tue Wed Thu Fri Sat
-
Cance
3 4 T 2 9 10 11
12 13 14 15 16 17 12 Symbol
19 20 21 Py 23 24 5 & UPS Power Off
] 2? = - 30 & UPS Power On
® UPS Test
Task List
Type Date Start Time Cperate Delay Time RS
Once 200904502 [16:43:32 Shutoff UPS |[75hins Dell UPS RackiTowe
b
< >
[[Add UFS oot l| [ Modity ]| |

Figure 83. UPS On/0ff Manager Window
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Changing a Scheduled UPS On/Off Task
To modify a scheduled UPS On/Off task:

1  Select one of the UPS On/Off tasks in the task list.
2 Click Modify and update the schedule (see Figure 84).
3  Click OK to save and exit.

OPS On/Off

Once

UP5 On/0ff Hanager

April v‘ 2009 UPS Schedule Off
Sun Mon Tue Wed Power Off Once I@ v||4 v”z v|
: fresesz ]2
5 3] 1 3
12 13 14 15 FPower On Once |2UDQ v||4 v”z v|
19 a0 21 2 5
b 7 b 2 =
Selectthe UPS to be turned off
Task List COMT Dell UPS RackiTower 27
Type Date Start Time
< > Purge All |
£ f |
[ ok | [ cancel ||

Add UPS Qnjoft ! MDdig ll

Figure 84. Modify a Scheduled UPS On/Off Task
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Removing a UPS On/Off Task
To remove a scheduled UPS On/Off task:

1  Select a UPS On/Off task from the task list.

2 Click Remove to cancel the task (see Figure 85).

UPS On/Off Nanager 3
|Februar\f v| |zuug =
Sun hian Tue Wed Thu Fri Sat
1 2 3 4 5 4] T
z 9 10 11 12 13 14
E]
15 16 17 *| 12 19 20 21 Symbol
22 23 24 25 26 27 22 & UPS Power OFf
& LUPS Fower On
& UPS Test
Task List
Type Date Start Time Operate Delay Time LIPS
P 30 Shut off UPS  7aMing Dell UPS
b
< | ¥
[ Add UPS On/off || Mo o ify | C_ Remove ]|

Figure 85. Remove Scheduled UPS On/Off Task
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Viewing Scheduled Tasks

Select View Schedule from the UPS menu or click the &£ icon from the toolbar to open the View
Schedule window (see Figure 86). The View Schedule window displays only the tasks for the current
month. Select another month to display the tasks for that month.

Yiew Schedule rz|
v| 2008 =
Wed Thu Fri Sat
1 2 3 4 5 [} T
3 9 10 11 12 13 14
15 16 17 12 19 20 21 Syrribal
22 23 24 5 26 27 22 & UFPS Power OF
@ UPS Fower On
& UPS Test
Tasgk List
Type Date Start Time Operate Delay Time UFPS
A
hs/
< >

Figure 86. View Schedule Window
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Remotely Controlling a UPS on the LAN or Internet

You can remotely monitor any Dell UPS within the same LAN or on the Internet. Up to 32 remote

Agents can be monitored.

% NOTE: To remotely monitor any Dell UPS within the same LAN, the computers involved must have TCP/IP

communication protocol.

% NOTE: To remotely monitor any Dell UPS on the Internet, the computers involved must have TCP/IP

communication protocol and must be connected to the Internet.
To remotely control a UPS:

1 Test the performance of the physical network communication:

From a command prompt, enter the ping command with the IP address of the computer to be

monitored. Figure 87 shows that the physical link is in an optimal state.

S WINNT system32tcmd.exe

=10l x|

C:s>ping 192.168.1.228
Pinging 192_168.1_.228 with 32 bhytes of data:

Reply from 192 _168_.1.228: bytes=32 time{1Bms TTL=128
Reply from 192_168.1.228: bytes=32 time<{l@mz TIL=128
Reply from 192.168.1.228: bytes=32 time{1Bms TTL=128
Reply from 192_168.1.228: bytes=32 time<{1l@msz TIL=128

Ping statistics for 192_168.1_228:

Packets: Sent = 4, Received = 4. Lost = B {(B8x loss>.
Approximate round trip times in milli—seconds:

Hinimum = Bms,. Maximum = @ms,. Average = Bms

Figure 87. Pinging the Computer to be Monitored
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2 Enable the Accept Remote Control option in the Dell UPS Management Software:

Select Accept Remote Control from the Monitor menu (see Figure §8).

=:Dell UPS Nanagement Software — baocnw156102131 ——
System Logs UPS Tools Mun1t0r| Preferences Language Help

nitor Remote UPS

(I BV W Accept Remote Control

Figure 88. Accept Remote Control

The Dell UPS Management Software window opens (see Figure 89).

=u Dell UPS Nanagement Software —— baocnwl56102131 ——

System Logs UPS Tools Monitor SNMP Preferences Language Help

UPS MANAGEMENT SOFTWARE

From Bypass Command

Woltage 227 W
Fregquency 498 Hz

Cn Battery

[0000.00

hdodel Dell LUPS Racl oltage 2480 W
ARODA HY - Capacity G4 k)
230 Tirne rernaining 3 h 47 m 24
+ BUS Walt 1230 W 3
-BUSYalt [0 W gl.lg‘ IABM State Floating
pllhg Recent Events:

2009/07022 09:63:37 Input AC Underoltage
2009/07/22 09:50.52 AC Power Restared

Figure 89. Dell UPS Management Software Window
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Select a UPS to monitor:

Select the UPS from the tree view on the left side of the window or select Monitor Remote UPS
from the Monitor menu.

If you selected the UPS from the tree view, continue to Step 5.

If you selected Monitor Remote UPS, continue to Step 4.

The Monitor Remote UPS window opens (see Figure 90).

Enter an IP address (either IPv4 or IPv6 address) or host name of the Agent and then click OK.

Xonitor Remote OPS

Enter IP address or Host name of Agent

IP Address ar Host Mame l:l
C ok | cancel

Figure 90. Monitor Remote UPS Window

5

The UPS name displays in the tree view directory (in the LAN directory for LAN connections or in
the WAN directory for Internet connections).

If the Accept Remote Control option of the Agent is off, you can only remotely monitor the UPS.
All control functions are disabled (see Figure 91).

= Dell UFS Nanagement Software —— baocnwl56102131 (Read) ——

biEACI Gl Logs UPS Tools Konitor SNMP  Preferences Language Help

ENT SOFTWARE

35 Command

214
229 W Carnplex Power |0 WA
Headroom 5896 W

500 Hz Present 0

Figure 91. Control Functions Disabled
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If the Accept Remote Control option of the Agent is on, you can remotely monitor and control the
UPS. All control functions are available (see Figure 92).

=u Dell UPS Nanagement Software —— baocnwlb6102131 (Read) ——

ECT N Logs UPS Tools Monitor SNMP  Preferences Language Help
Act as Administrator
Modify Administrator Password |ENT SOFTWARE

Lacation IP Address Madel Status -
1LAN-=haocrel 56, 17218127126 — Dell UPS Rac... From Bypass Co.. [

Figure 92. Control Functions Enabled

You can manually delete a remote Agent by right-clicking the selected Agent and clicking Delete
(see Figure 93).

=u Dell UPS Nanagement Software —— baocnwl56102131 (Read) ——

System Logs UPS Tools Monitor SKNMP  Preferences Language Help

UPS MANAGEMENT SOFTWARE

Location IP Address Alias hadel Status -

L
&4l WAN 1hAN-=haocrwl 8. 127.18.127.688 —

Cell UPS Rac... From Bypass Co..

Figure 93. Delete Remote Agent
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Monitoring a UPS through SNMP

You can use SNMP to monitor UPSs that have a Network Management Card installed. Up to 1,000
SNMP nodes can be monitored.

To add an area to the SNMP node:

1  Select the SNMP node from the tree view on the left side of the window.

2 Click Add Area from the SNMP menu.

3 Enter the geographic address of the SNMP card and click OK (see Figure 94).

Add Area X
oK ]| [ cancel ]|

Figure 94. Add Area Window
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The new area displays under the SNMP node in the tree view (sce Figure 95).

= Dell UPS Nanagement Software — SHEP->TC —

System Logs UPS Tools Monitor SKMP  Preferences Language Help

D&LLL uPs MANAGEMENT SOFTWARE

=-§* Root Location IP Address Alias Status ~
% LAN ~
v VAN
=B snmp
£

0% b

Figure 95. New SNMP Area
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To add devices:
1 Click Search Device from the SNMP menu.

2 Sclect the Internet Protocol Version supported by SNMP from the Protocol Type list
(see Figure 96).

% NOTE: The Protocol Type list displays only if both IPv4 and IPv6 are enabled.

% NOTE: For IPv4, both single device and segment devices searches are supported.

3 IPv4 only. Enter an IPv4 address in the Start IP field and the End IP field (sce Figure 96).

Search Dewice E|
Protocol Type Pratocal [Pvd J&

Area Mame

Start IP . .

End IP . .

Public Community

Found Device:

Added Device:

[Eeaen )| | Ceiese

Figure 96. Search Device Window (IPv4)
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4  IPv6 only. Enter the device's IP address (see Figure 97).

% NOTE: If the IPv6 address is a broadcast IP, all Network Management Cards that support IPv6 within the LAN
are found. The default IPv6 address is broadcast IP ff02::1.

Search Device g|

Pratocal Type

Area Mame

IP Address |

Public Community |:|

Found Device: 1
Added Device: a
[IIIIIIIIIIIII

Search | Cancel | Close |

Figure 97. Search Device Window (IPv6)
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5  Click Search.

After searching, the new device displays in the tree view (see Figure 98).

=i Dell TPS Nanagement Software — SNEP->IC —

System Logs UPS Tools Monitor SNWP Preferences Language Help

UPS MANAGEMENT SOFTWARE

hdodel Status »

=-#* Root Location IP Address Alias
8
L ‘é" {;‘:::] 1/SMMP-=TC 17218127.89 17218.127.89 |Dell UPS Rac... \UPS Output Off 0%
vz W i
= Be SHMP | 2 BNMP-TC 17218127.74 17218127.74 Dell UPS Rac... Mormal 0%

= O i@

28

Figure 98. New Device in SNMP Area

NOTE: If one or more SNMP IP addresses in the search range are disabled, a pop-up window opens displaying
the disabled IP addresses (see Figure 99). Select the IP address to go to the Network Management Card's Web

page and configure the SNMP IP settings to enable the IP address.

~. HEC SHNP Disabled IP Address [X|

Flease Enahle MMC ShkiP
And Check MMC SMMP Read Community.
17218127 47

Close

Figure 99. Disabled IP Address Window
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6  Double-click the new device node to connect it with the Internet browser of the Network
Management Card (sce Figure 100). The Link column indicates successful communication.

= Dell UPS Eanagement Software — SHEP->TC ——

System Logs UPS Tools Monitor SKMP  Preferences Language Help

DEALL ups MANAGEMENT SOFTWARE

Laocatian IP Address Alias Madel Status =
1| SHMP==TC 172.19.127.89 17218.127.88 Dell UPS Rac.. |UPS Output 0ff (0% é &
2 SHNMP-=TC 1721812774 1721812774 Dell UPS Rac_. Mormal 0% ¥
v.
2% | b

Figure 100. Successful Link
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7 Toview the event records for any Dell UPS monitored by a Network Management Card, select the
UPS under the SNMP node in the tree view and select SNMP Event Log from the SNMP menu.
The Event Log for the selected UPS opens (see Figure 101).

SNEF Event Log r§|

EventLog Record Ma; 1-616

LJC_DatE  JC__TME J([EVENTTYPE J(DELETE )

,-"':' 2009/04502 16:45:09 1721812716 0n All Devices AC Power Failure [

,;\ 200904502 16:46:09 1721812716 0n All Devices Bypass OverUnder Freguency il

,;\ 2009/04f02 1645058 |172.18127.16in All Devices Input AC Undenvoltage il

,;\ 2009/04502 164508 1721812716 in All Devices Input UndenQwer Frequency il

,;\ 200904002 16:46:09 1721812716 in All Dewices WHility Mot Present O

,;\ 2009504002 16:45:03 17218127 16 in All Devices Bypass Mot Available P
¥
[
[
L
L
L
L
L
L

| | | | [Qelete” [Eurge AII]| [Egpon” [anse”

Figure 101. Event Log

8  To set the maximum Event Log file length for any Dell UPS monitored by the Network
Management Card, select Event Log Setting from the SNMP menu. The default file length is
5,000 rows, and the maximum value is 100,000 rows (see Figure 102).

Event Log Setting

Max File Length | 5000 | Rowis)

ok [ cuead |

Figure 102. Event Log Setting Window
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Rebooting Computers after a Utility Failure

You can reboot individual computers or all computers on the LAN automatically after a utility power
failure.

To configure the computers to reboot when the utility power restores:

1 Seclect Wake Up from the UPS menu to open the Wake on LAN window (see Figure 103).

¥ake on LAN X]
Input MAC Address

[15electall

[ aod ) [_oeet
[ oK ]‘[ Cancel ]|

Figure 103. Wake on LAN Window

2 Toreboot all computers, select the Select all check box and click OK.
3 Toreboot individual computers:

e Enter the MAC address for the computer. You can use the ipconfig —all command to identify
the MAC address of the computer.

4 NOTE: DO NOT enter the dash (-) of the MAC address.

e Click Add.

*  Repeat for each computer that should be rebooted when the utility power restores.
4  Dell recommends to test the reboot function.

To test the reboot function, select the computers from the list and click Test. The computers
should reboot.
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Exporting Configuration Parameters

Instead of configuring the software settings individually on multiple computers, you can easily copy the
software configuration parameters to another computer.

To copy the configuration parameters to another computer:

1 From the configured Agent, sclect Export Configuration from the System menu (see Figure 104).

= Dell UPS Eanagement Software —— baocnwl56102131 —

Logs UPS5 Tools WMonitor SHMFP Preferences Language Help

Idodify Administrator Password |ENT SOFTWARE
Auto Search UPS

From Bypass Command
Import Configuration... 174
Export Configuration... Yaltage 997 Woltage 228 W

Freguency 0.0 Hz [rozqduency SD'D gz
Current 0o A
CHEER Fower i W

0o:00:00

N |
(4G LINE Jeommamm] UPS [ 070 [

173
kdodel Ciell UPS Rack/ I Waltage 248.0 W
AE00WY HY - Capacity 94 o
230 Time remaining 3h4?m46
+ BUS Volt 230 W BAWERY
-BUSWalt |0 W IABM State Floatmg
1B SNMP

Recent Events:
2009/07722 11:25:67 Agent Start

Figure 104. Export Configuration

The software exports a file that contains the saved configuration parameters, such as local UPS
information, Network Management Card settings, shutdown parameters, and alarm settings.

2  Save the *.ini file.
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3 From the new Agent, select Import Configuration from the System menu (see Figure 105).

4  Seclect the *.ini file and click OK.

Once the configuration parameters are imported, the settings take effect immediately.

== Dell UPS Hanagement Software — baoccnwl56102131 —

S){stem| Logs UPS Tools Monitor SKNMP Preferences Language Help

Modify Administrator Password |ENT SOFTWARE
Auto Search UPS

From Bypass Command

Import Configuration.

114
Export Configuration... Yoltage 297y \Firoeltaf:m gé&u \'._f|Z
Freguency 50.0 Hz Loaqd H 0 )

[On Batery Current 00 A

\ T Fower |U W

(A LN Jemmm UPS a7

113

hiodel Cell UFS Rack-/’/, I Woltage 248.0 W
RO HY - Capacity 44 k]
230y BATT Time remaining |3 h 47 m 46

1
+BUS Vall 230 % ERY 5
B WAN ~BUS Yol 0 % oy IAEIM State Floafing
BBy SHMP

Recent Events:
2009/07/22 11:25:87 Agent Start

Figure 105. Import Configuration
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Event Descriptions

This chapter lists events logged by the Dell UPS Management Software (see “Viewing the Event Log”
on page 41). Events can be set up to send an event message through broadcasting, e-mail, and text
messaging. Some events can also be sent as a page to configured pagers, or set up to open a message
window on your computer. See “Configuring Event Actions” on page 44.

Number Event Description Type of Message Remarks

1 UPS Battery Low Serious In the Shutdown Settings, select
UPS Battery Low so that when
this event occurs, the UPS shuts
down according to the shutdown

parameters.
2 UPS Output Overload Serious Output load is more than 110%.
3 Communication Lost Warning The communication cable is not

connected, or there is a
communication port fault.

4 AC Fail Warning

5 On Bypass Warning The UPS transfers to Bypass
mode because of overload,
hardware fault, or other
conditions. An online UPS is
also in Bypass mode when it is
off, at which time the UPS
provides no protection.

6 Battery Test Fail Warning

7 AC Restore Information

8 Communication Established Information

9 Agent Start Information

10 Agent Stop Information

11 System to be Shut Down Information

12 System to be Shut Down by Information Set the Agent to respond to

Another Agent through Shutdown Settings.

13 Specific Date UPS Shutdown Information

14 Weekly UPS Shutdown Information

15 Self-Test Started Information Self-test begins immediately.

16 Self-Test Canceled Information
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Number Event Description Type of Message Remarks

17 Self-Test Ended Information

18 Specific Date Self-Test Started  Information

19 Specific Date Self-Test Information
Canceled

20 Specific Date Self-Test Ended  Information

21 Monthly Self-Test Started Information

22 Monthly Self-Test Canceled Information

23 Monthly Self-Test Ended Information

24 UPS Control Power ON none

25 On Manual Bypass Alarm only Applies to 5600W and
double-conversion UPS models
only.

26 In High Efficiency Mode none Applies to double-conversion
UPS models only.

27 ON Buck / Input Voltage none

Reducer
28 ON Boost / Input Voltage none
Booster

29 ABM State Charging none

30 ABM State Floating none

31 ABM State Resting none

32 ABM State OFF none

33 Clock Set Done none

34 To Bypass Command none Applies to 5600W and
double-conversion UPS models
only.

35 From Bypass Command none Applies to 5600W and
double-conversion UPS models
only.

36 UPS On Command none

37 UPS Off Command none

38 Battery Disconnected Alarm only

39 Shutdown Imminent Alarm only
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Number Event Description Type of Message Remarks

40 Service Battery Alarm and disables battery
charging (ABM in Charger Off
mode)

41 Utility Not Present Alarm and transfers to battery if ~ Utility level has fallen below the
supporting the load; otherwise,  Utility Not Present threshold
powers down (typically < 25 to 50V).

42 Bypass Not Available Alarm and inhibits bypass Applies to 5600W and
transfer double-conversion UPS models

only.

43 Input AC Overvoltage Alarm and transfers to battery if
supporting the load; otherwise,
turns off converters

44 Input AC Undervoltage Alarm and transfers to battery if
supporting the load or powers
down if not

45 Input Under/Over Frequency Alarm and transfers to battery if
supporting the load

46 Site Wiring Problem Alarm only

47 Remote Emergency Power Off  Alarm and de-energizes load and
enters standby mode

48 Overload 1.2 Alarm and then transfers to
bypass in 2 minutes

49 Overload 1.3 Alarm and then transfers to
bypass in 30 seconds

50 Battery DC Overvoltage Alarm only

51 Charger Failure Alarm only

52 Inverter AC Overvoltage Alarm and then transfers to Applies to double-conversion
bypass if supporting the load or ~ UPS models only.
if converters are off

53 Inverter AC Undervoltage Alarm and transfers to bypass if ~ Applies to double-conversion
supporting the load or if UPS models only.
converters are off

54 Rectifier Input Overcurrent Alarm and transfers to battery if ~ Applies to double-conversion
supporting the load or if UPS models only.
converters are off

55 Inverter Output Overcurrent Alarm and transfers to bypass if ~ Applies to double-conversion

supporting the load or if
converters are off

UPS models only.
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Number Event Description Type of Message Remarks

56 DC Link Overvoltage Alarm and transfers to bypass if ~ Applies to double-conversion
supporting the load or if UPS models only.
converters are off

57 DC Link Undervoltage Alarm and transfers to bypass if ~ Applies to double-conversion
supporting the load or if UPS models only.
converters are off

58 Inverter Fault Alarm and inhibits recovery Applies to double-conversion
attempts UPS models only.

59 Rectifier Fault Alarm and inhibit recovery Applies to double-conversion
attempts UPS models only.

60 Output Short Circuit Alarm

61 Heatsink Overtemperature Alarm and transfer to bypass if
supporting the load or if
converters are off

62 Fatal EEPROM Fault Alarm only

63 Fan Failure Alarm only

64 DC Link Imbalance Alarm and transfers to bypass if ~ Applies to double-conversion
supporting the load or if UPS models only.
converters are off

65 Bypass Over/Under Frequency ~ Alarm only

66 Warranty Period Has Expired Information

67 Warranty Period Is Less Than Information

One Year
68 Output Off Alarm only
69 Output Normal Information
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Installation on a VMware ESX Server

This guide describes the installation and configuration of the Dell UPS Management Software on a
VMware® ESX® Server.

Dell UPS Management Software allows you to connect a 3.x or 4.x VMware ESX Server with a UPS
through the UPS RS-232 port, USB port, or through the Network Management Card. The software will
be monitored and configured by a remote Agent on either a Microsoft Windows or Linux platform (see

Figure 106).

The software notifies the VMware server of power events or UPS alerts with pop-up broadcast
information on the console. It also safely shuts down the VMware ESX server and the guest operating
system.

Before the VMware ESX system shuts down, use the shutdown.sh script to shut down the guest
operating system.

All operations are tested on VMware server with two guest operating systems (SBS 2003 and Red Hat)
when the certain conditions exist, such as:

e UPS Battery is low
* Battery backup time is reached

e Battery discharge time is reached

Tested operations include:
e Safely shuts down the VMware server
e Safely shuts down the guest operating system

e Software notifies the VMware server of power events or the UPS alerts
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Figure 106 shows an overview of the VMware environment.

Virtual/ Virtual/ Virtual/
Guest 081 Guest 0S2 Guest 0Sn
(Windows) (Linux) (Solaris)
Applications, Applications, Applications,
Services, etc. Services, etc. Services, etc.

!

! i

VMware Server ESX Server Agent

Dell Software

I RS-232/USB/Network Management Card

Dell UPS

Figure 106. VMware ESX Environment Structure Overview
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Installation

This guide provides information about installing and configuring Dell UPS Management Software on a
VMware ESX server and installing VMware Tools on a guest operating system.

Prerequisites
e VMware ESX Server with 125 MB free space for the software.

e  VMware Infrastructure client must be installed on different machine.

Dell UPS Management Software Installation

To install the software:

1 Download the software from the Dell Web site (support.dell.com) or from the CD (F618R A04 or
higher) provided with the UPS.

2 Toinstall the software from the CD, enter the following command:

mount /dev/cdrom /mnt
cd /mnt/Linux
/setup_console.bin

3 To install the software file downloaded from the Dell Web site:
e Go to the location where the software was downloaded.
*  Enter tar —zxvf UPSMS_setup_Linux.tar.gz to extract the file.
e  Enter ./setup_console.bin to install the software.

4  Enter the installation path: /opt/ups

5 To start the Agent, enter the command:

Jagent start
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Installing VMware Tools on a Microsoft Windows Guest
To install the VMware Tools for a Microsoft Windows guest:

1 Onthe VM Templates page, select the virtual machine template name and then select the

Console tab. The virtual machine console displays (see Figure 107).

rF 172.18.127.11 - vSphere Client

—|=] x|
File Edit View Inventory Administration Plugins Help

a a ‘Eﬂ Home b g Inventory D Inventory
nir ¢6 G Rlo e @

B @ 17218.127.11 windows2003

Getting Started | Summary | ResourceAllocation ' Performance | Events E@GUELI Permissions

Virtual Machine
Template Name I

/ 7 Windows Server2003
¥ Standard Edition

Capyright © 1885-2003 Micrasaft Corparation

&= Press Curlalt-Delete to begin.

Requiring this key combination at startupMelps keep your
computer secure. For more information, click Help,

Recent Tasks
Name | Target | Status | Details | itiated by | Requested Start Time < | Start Time | Completed Time |
¥4 Power Onvirtual machine B windows203 & Completed root 2/25(2010 10:41:24PM  2/25/2010 10:41:24 ... 2/25/2010 10:41:27 ..
[¢] Tasks | root

E 3 by | B <% A e o
[ ﬁ % l_»;u] - @ “’:j Pl ) yepaoes B

Figure 107. Console Window

2 Insert and start the Microsoft Windows operating system installation CD.
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3 Login to the guest operating system from the virtual machine console.

4  Select the template name and then right-click and select Install/Upgrade VMware Tools from the
menu (see Figure 108).

% 166.99.170.33 - VMware Infrastructure Client

File Edit Views Inwventory Administration Plugins Help

Inventary Administration
a B | 3 @ lEH conrect Floppy 1 Conne
=3 Iocalho.st.napa.ad.etn.com. indowsXPSPZ

@ PoolPunelab2
@ RHEL4 &4-bit:

(T vima
s vMa
@ wMa-ovf-4.0.0-161993 Description
s o presate
Povwer OFF Chrl+E ote consol
Suspend Chri+2 hest.napa..
Reset b pnapa.ade
.napa.ad.e
oke consal
lhost.napa..
Snapshot 3 pchine
.napa.ad.e
Add Permission... .napa.ad.e
Open Console llapgaie
g .napa.ad.e
ote consal
oke consol
Report Performance. .. oke consol
oke consal
ote consol
Edit Settings... S—
Rename .napa.ad.e
o] f .napa.ad.e
ng
schine
Migrate starage...

(ﬁ Being created on host localhost.na

Figure 108. Virtual Machine Template Menu
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From within the guest operating system, click OK to confirm that you want to install VMware
Tools and launch the Install Shield wizard.

e Ifauto-run is enabled in the guest operating system (the default setting for Microsoft
Windows operating systems), a window opens.

e [f auto-run is not enabled, run the VMware Tools installer. Click Start > Run and enter
D:\setup.exe, where D: is the first virtual CD-ROM drive.

Follow the on-screen instructions.

*  On Microsoft Windows Server 2003, the SVGA driver is installed automatically, and the
guest operating system uses it after it reboots.

e After you install VMware Tools, Microsoft Windows 2000 and Microsoft Windows XP guest
operating systems must be rebooted to use the new driver.
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Installing VMware Tools on a Linux Guest

The VMware Tools installation package is on the VMware server installation CD on the path
\VMware\RPMS.

1 Onthe VM Templates page, select the virtual machine template name and then select the
Console tab. The virtual machine console displays (see Figure 109).

(%7 172.18.127.11 - vSphere Client

-8 x]
File Edit View Inventory Administration Plugdns Help
E ; ‘_a Home b gf] Inventory B [l Inventory
wmulp &loeBoe

ERE] 8.127.11

u3phere Management Assziztant 4.8.8
Kernel Z2.6.18-128.1.1.el5 on an x86_64

Virtual Machine liugiong login: _
Template Name

Recent Tasks x
Name | Target | status | Details | nitisted by | Requested Start Time = | Start Time | Completed Time |
¥ Power Onvirtual machine &1 vMa4D @ Complated root 2/24/2010 5:21:25 PM 2/24[2010 5:21:25 PM 2/24/2010 5:21:30 PM
ﬂ Power On virtual machine ed & Completed root 2/24/2010 5:21:15 PM 2/24/2010 5:21:15 PM 2/24/2010 5:21:18 PM
@ Power On virtual machine 003 @ Completed root 2/24/2010 5:21:05 PM 2/24/2010 5:21:05 PM 2/24/2010 5:21:07 PM
&Y Autopoweron @ Completed root 2/24/2010 5:21:05 PM 2/24/2010 5:21:05FM  2/24/2010 5:21:35FM x|
[ATasks | oot

Figure 109. Console Window
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2 Insert and start the VMware server installation CD.

3 Login to the guest operating system from the virtual machine console (see Figure 110).

23] 172.18.127.11 - vSphere Client _1&lx]
File Edit View Inventory Administration Plug-ns Help
ﬁ ‘zj Home D gf] Inventory b [l Inventory
I I B e e e
B [ 17218.127.11
(s redhats
s [VMAag

& windows2003

vSphere Management Assistant 4.8.8
Kernel 2.6.18-128.1.1.e15 on an x86_64

lingiong login: vi-admin
Password:
Last login: Mon Jan 25 8@8:54:55 on ttyl

Welcome to vMA
run ’‘vma-help’ or see http://uww.vmuare.comsgosvmad for more details.

[vi-admin@liugiong ~15

Recent Tasks X

Name | Target | Status | Details | Initiated by | Requested Start Time — | Start Time | Completed Time

[FATasks | [ront

Figure 110. Console Window — Log In

4  Seclect the template name and then right-click and select Install/Upgrade VMware Tools from the
menu (see Figure 108).

5 Mount the CD with the command:
mount /dev/cdrom /mnt
6  Install the package with the command:

cd /mnt/VMware/RPMS
rpm —Uvh VMware-esx-tools-3.5.0-123630.i386.rpm

4 NOTE: The package name is likely to be different.
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7  Contfigure the VMware Tools with the command:
vmware-config-tools.pl

8  Enter number: 1

9  Start the VMware Tools with the command:

vmware-toolbox &

VMware Tools on the summary row displays OK if the tools are available (see Figure 111).

(%) 172 18. 127. 160 — VEware Infrastructure Client

Tile Edit View Inventory Adninistration Flugins Help

»

Tnventory  Adnimistration

- p 0 p B I comect 3BIBHE] 1 () Connecr CI/DVD BREHER 1 [ ]
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= [ locahost lacaldomain TR
redhats
%
General
Guest O5: Microsoft Windows Server 2003 5 ...
CPLU: 1vCPU

Memary: 256 MB
Memory Overhead: 81,69 MB

OK indicates ————e [ yrmwers roas: '3

CPUl usage:
Host memary usage:

Guest memory usage:

Datastore
B storagel

Network
@ M network

12 MHz

208.00 MB

13.00 MB
Capatity Fres
140,50 GB: 123.70 G

IP Addresses: 172.18.127.194
that VMWare DS Marne: santak-35qvw7rs.
Tools are
. State: Powered On
available. Hose: localhost Jocaldomain
Activg Tasks:
Commands

Poier off
10 suspend

Y Reset

% Edit Settinas

Recent Tasks

Hame Target Status

¢ BshE & redhats @ Completed
23]

& Tasks

Tritiated by
root

Time | Start Time

2008-12-26 1:29:16  2008-12-26 1:29:16
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Figure 111. VMware Tools Available
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Configuration

This section explains configuration for the Dell UPS Management Software and for the VMware server.

VMware Server Configuration

All hardware elements must have an operational network configuration that allows them to
communicate freely with each other. Dell UPS Management Software uses TCP and UDP for
communication with UPS.

To configure the VMware Server:

1 Confirm that the following UDP ports are opened on the ESX server I'irewall. Check the ports
according to the following table:

Communication Mode Ports
USB/RS-232 2198, 2199, 2200
Network Management Card 161, 162, 3369

Example command:
esxcfg-firewall -0 2198,udp,in,UPSMS
2 Confirm that the following TCP ports are opened on the ESX server Firewall: 2099
Example command:
esxcfg-firewall -0 2099,tcp,in,UPSMS
3 Ifyou want to disable the firewall permanently, enter the command:
chkconfig iptables stop
4  To disable the firewall temporarily, enter the command:

service iptables stop
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Communication Through an RS-232 or USB Port
% NOTE: USB communication is only available for VMware ESX 4.0.

The VMware server works in console mode and cannot be used for configuration. Use a remote Agent
with the same Dell UPS Management Software version to configure the VMware server.

1 Start the manager interface on the remote software Agent in the Microsoft Windows operating
system.

2 If the two Agents are in the same LAN, the VMware server client will be added to the topology
automatically; otherwise, add the Agent manually (select Monitor Remote Device from the
Monitor menu).

The software automatically searches for the UPS when the Agent starts for the first time after
installation.

If the search fails:
e Seclect the VMware Server Agent from the tree view.

e Acting as the Administrator, select Auto Search Device from the System menu. The UPS
connected with VMware Server appears in the LAN tree view (see Figure 112).

=u Dell UPS Management Software — localhost ——

System Logs UPS Tools Monitor SKWMP  Preferences Language Help

D&ALL | UPs MANAGEMENT SOFTWARE

UPS Self-Test: Aharted

175
Waltage 2249 W

m
> Frece o BYPASS Freguency 500 Hz
m Freguency 500 Hz Freqt ’ H
! On Battery Current 0.0 A
- Power 1] Wy
g 00:00:00
¥ BAOCKIAN 54400067 N |
- P
= AC LINE ==t
-
-t
114
¥z WAN Gel P

o B SHMP

Waltage 2480 W
Rack SE00W | Capatity g8 %
High Time remaining 5 h 43m
Efficiency BAEERY 21
1]

5
Online HY - IAEIM State Floating

Recent Events:

Figure 112. UPS Connected to the VMware Server
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3 Select Shutdown Parameter from the UPS menu.

4  On the Shutdown Settings page (see Figure 113):
e Set the battery backup time
e Sclect the Begin Shutdown Immediately if Battery Low check box
¢ Select the Run Command File before Shutdown check box

*  Set the Shutdown File Max Execution Time. Allow at least 30 seconds for each guest
operating system shutdown.

Shutdown Settings rg|
Shutdown Options
| riewitys0 ~| | Dell UPS Rack 8500w High Efficiency Online Hy -230v v |
[w] Allow battery to discharge for 10 min 0 SEC
Shut down when remaining hattery time is below 2 min 0 SEC

Begin Shutdown Immediately if Battery Low
Systern (=) Shutdown [Redundant UPglnputSettinJ
Time needed for system shutdown 2 min

Powered by Load Segmentl

[ Remote Shutdown by Agent

l:l min shut down system

I RunlCommand File hefore Shutdown

Shutdown File Max Execution Time 1 min

Shutdown Conditions

Shutdown Conditions Agents to be shut down m

Bemove

Shutdown Alarm Parameters

Shutdown Alarm Interval 1 min

StartWarning before Scheduled Shutdown (10 min

[ QK ]| [ Cancel ]|

Figure 113. Shutdown Options
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Communicating Through the Network Management Card
ﬁ NOTE: See Table 4 on page 133 for a complete list of Dell Command User Interface (CUI) commands.

The following procedure is an example of a user entering the settings for a graceful shutdown of selected
devices through the network management card:

1  Enter the installation path: /opt/ups
2 Enter ./CuiManager to start the CuiManager (see Figure 114).

3 Search for a single device by entering search4 and the device network I[P address, or search for
multiple devices within a range.

Example command:
search4 —ip 172.18.127.1 —ip 172.18.127.254 —c public
All devices in the network IP address from 172.18.127.1 to 172.18.127.254 are added.

Dell_UPS_Management_Software_Installlog.log

[vi-admin@liugiong ups1$ sudo .- agent start

Starting Agent:

Done

[vi-adminPliugiong ups1$|. CuiManager

CuiManager is starting...

Dell UPS Management Software - only for SNMP Device, wversion: B1.85.8884 Z889-81
-22

Ainy command using option “-help” will show it's messages??

Dell Managerisearchd -ip 172.18.127.1 -ip 172.18.127.254 -c public
Searching SNMP from 172.18.127.1 to 172.18.127.254

Start Searching Thread. ..

Dell MawnagerSearch is Completed, Found 3 UPS, Added 3 UPS

Dell Manager:list

ip

172.18.127.75

172.18.127.24 Powerware BladelUP3

172.18.127 .47 Dell UPS BRack 4Z288W High Efficiency Online HU - 238U
Dell Manager>_

Figure 114. Searching for Devices
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Enter the shutdown commands (sce Figure 115).
Example:

shutsys ip 172.18.127.47 e true

shutbackup ip 172.18.127.47 e true m 1:00
shutfile e true f shutdown.sh m 2

listshut —ip 172.18.127.47

NOTE: See "Dell CUI Commands” on page 133 for a description of all Dell CUl commands.

NOTE: Each guest operating system requires a minimum of 30 seconds to run the command file before
shutdown. The -m 1 option in the shutfile command in the example below sets one minute as the total time
allowed to run the command file before shutdown, which allows sufficient time for two guest operating systems.

Example: shutfile -e true -f shutdown.sh -m 1

The host and guest operating system shut down orderly and gracefully after the battery discharges

for one minute.

[vi-admin@Pliugiong up=s15 .,CuiManager

CuiManager is starting...

Dell UFPS Management 3oftware - only for 3SNMP Device, version: 81.85.8884 Z68A9-B1
-22

Any command using option “"-help" will show it’'s messagest?!

Dell Manager>shutsys -ip 172.18.127.47 -e true

Dell Manager>zhutbackup -ip 172.18.127.47 -e true -m 1:H8

Dell Manager>shutfile -e true -f shutdown.sh -m 2

Dell Manager>listshut -ip 172.18.127.47

172.18.127 .47 Dell UPS Rack 42Z88W High Efficiency Online HVU - 238V

Allow battery to discharge for Enable a1:a8

Shut down when remaining battery time is below Disable 8z2:a8

Begin Shutdown Immediately if Battery Low Disable

System Enable

Powered by Load Segmentl

Run Command File before Shutdoun Enable sopt/sups/shutdouw

Shutdown File Max Execution Time 2 min

Dell Manager>_

Figure 115. Shutdown Parameters
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Installation on a VMware ESXi Server

This guide describes the installation and configuration of the Dell UPS Management Software on a
VMware® ESXi® Server.

The Dell UPS Management Software agent cannot be installed on the hypervisor system because
VMware® ESXi does not have an administrative console for hypervisor. However, the software can be
installed on VMware Infrastructure Management Assistant (VIMA) 1.0 or on vSphere Management
Assistant (vYMA) 4.0 to manage the shutdown of VMware ESXi hosts. You can configure the ESXi to
safely and orderly suspend or shutdown guest operating systems by configuring the ESXi hypervisor.
This allows one Dell Software agent on one guest operating system (VIMA/VMA).

Dell UPS Management Software allows you to connect a 3.x or 4.x VMware ESXi with a UPS through
the Network Management Card.

The software notifies the VMware server of power events or UPS alerts with pop-up broadcast
information on the console. It also safely shuts down the VMware ESXi server and the guest operating
system.

Before the VMware ESX system shuts down, use the shutdownESXi.sh script to shut down the guest
operating system.

All operations are tested on VMware server with two guest operating systems (SBS 2003 and Red Hat)
when certain conditions exist, such as:

e UPS battery is low
e Battery backup time is reached

 Battery discharge time is reached

Tested operations include:
e Safe shut down of the VMware server
o Safe shut down of the guest operating system

* Notifications of any power events or UPS alerts to the VMware server
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VMware Server ESXi Hypervisor

I Network Management Card
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Figure 116. VMware ESXi Environment Structure Overview
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Installation and Configuration

This guide provides information about installing and configuring the Dell UPS Management Software
on a VMware ESXi server and installing VMware Tools and vMA 4.0 on a guest operating system.

Prerequisites

VMware ESXi server machine
VIMA 1.0 or vMA 4.0 installed as guest

VMware Infrastructure client installed on a different machine for VMware ESXi Server
configuration

Secure Copy Protocol (SCP) client like WinSCP to upload packages to the VMware ESXi server
Dell UPS Management Software installed on the vMA

vMA Installation
To install the vMA application:

1

Go to http://www.vmware.com/support/developer/vima/ to download the software from the
VMware Web site.

Unzip the vMA virtual application package.
Start the VMware Infrastructure client:

e Select File > Deploy OVF Template.
e Click Browse.

*  Select the Open Virtualization Format (OVF) and click Next.
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vMA Configuration

To configure the vVMA software:

4 NOTE: The default user name is vi-admin.

1  Enter the following command to add Target Servers to vMA:
sudo vifp addserver <servername>
Example command: sudo vifp addserver 172.18.127.11

2 Enter the following command to enable seamless authentication for remote CLI and VI Perl
Toolkit:

Example command: sudo vifpinit 172.18.127.11

3 Verify that the target server has been added. Enter the following command to display target
servers:

sudo vifp listservers

Example response: 172.18.127.11 ESXi

VMware ESXi Server Configuration

To allow interactions between physical and virtual machines, VMware tools must be installed on each
virtual machine. Go to http://www.vmware.com/pdf/osp_install_guide.pdf to download the VMware
Tools Installation Guide Operating System Specific Packages on the VMware Web site for further

information.
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Installing VMware Tools on a Microsoft Windows Guest Operating System
To install the VMware Tools for a Microsoft Windows guest operating system:

1

Console tab. The Console window opens (see Figure 117).

On the VM Templates page, select the virtual machine template name and then select the

) 172.18.127.11 - vSphere Client

Fle Edt View Inventory Administration Plugins Help

=1&l x|

B3 |Q Home P gF Inventory b [Efl Inventory

wle @

& B 2

S @ 17218.127.11
(@ redhats

Virtual Machine
Template Name

windows2003

Getting Started | Summary | ResourceAllocation | Performance Evenmym\ssmns

Welcome to Windows

/ 7 Windows Serveraoos
¥ Standard Edition

Gopyright & 1885-2003 Micrasal Corparation

S5 Press Ctrl-alt-Delste to bagin,

Reduiring this key combination at startup Helps kesp your
computer sscurs, For mors information, click Help.

Recent Tasks
Name | Target | Status | Details Initisted by | Requested Start Time — | Start Time | Completed Time |
@ Power Onvirtual machine @ windows2003 @ Completed root 2/25/2010 10:41:24 PM 2/25/2010 10:41:24 .. 2/25/2010 10:41:27 ...

[£9 Tasks

2/8/2006

oot

o] 31| % & | 2|@[E ]

Figure 117. Console Window

2

Insert and start the Microsoft Windows operating system installation CD.
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3 Login to the guest operating system from the virtual machine console.

4  Select the template name and then right-click and select Guest>Install/Upgrade VMware Tools
from the menu. (see Figure 118.)

r'-? 172.18.127.11 - vSphere Client
File Edit View Inventory Administration PlugHns Help

‘Eﬁ Home b g Inventory P [El Inventory
IEEEEELCE

ENE] 52.13.12?-11 windows2003
redhats

5;, VMA4.0

G-e-tting-Started Summary I'ResourceAllocation | Perfor

| Guest » | Answer Question...
Snapshot 4 Enter Full Screen (Cirl+Alt+Enter)
¥  open Console Send Ctrl+alt+del

G  Edit Settings. ..

Install/Upgrade YMware Tools

Add Permission... Cirl+P

Report Performance. ..

Rename Capyright @ 1885-2003 Mi

User name: I Adri
Password: I

Remove from Inventory
Delete from Disk

Recent Tasks

Figure 118. Virtual Machine Template Menu
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From within the guest operating system, click OK to confirm that you want to install VMware
Tools and launch the Install Shield wizard.

e Ifauto-run is enabled in the guest operating system (the default setting for Microsoft
Windows operating systems), a window opens.

e [f auto-run is not enabled, run the VMware Tools installer. Click Start > Run and enter
D:\setup.exe, where D: is the first virtual CD-ROM drive.

Follow the on-screen instructions.

*  On Microsoft Windows Server 2003, the SVGA driver is installed automatically, and the
guest operating system uses it after it reboots.

e After you install VMware Tools, Microsoft Windows 2000 and Microsoft Windows XP guest
operating systems must be rebooted to use the new driver.
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Installing VMware Tools on a Linux Guest Operating System

To install the VMware Tools for a Linux guest operating system:

1 Onthe VM Templates page, select the virtual machine template name and then select the

Console tab. The Console window opens (see Figure 119).

[ 172.18.127.11 - vSphere Client -
File Edit View Inventory Administration Plugns Help

G e |;_§ Home b gF] Inventory b [3fl Inventory

= [@ 17218.127.11
s

fi_redhats
£ windows2003

. . vSphere Management Assistant 4.8.8
Virtual Machine Kernel 2.6.18-128.1.1.e15 on an x86_64

Template Name

liugiong login:

Recent Tasks x
Name | Target | status | Details | Initiated by | Requested Start Time ~ | Start Time | Completed Time | -
¥ Power On virtual machine & vMadD @ Completed root 2/24/2010 5:21:25 PM 2/24/2010 5:21:25 PM  2/24/2010 5:21:30 PM j
#9 Power Onvirtual machine G 3 @ Completed root 2/24/2010 5:21:15 PM 2/24/2010 5:21:15 PM  2/24/2010 5:21:16 FM

¥4 Power Onvirtual machine @1 windows2003 @& Completed root 2/24/2010 5:21:05 PM 2/24/2010 5:21:05 PM  2/24/2010 5:21:07 PM

§Y AutopovierOn @ Completed root 2/24/2010 5:21:05 PM 2/24/2010 5:21:05FM  2/24/2010 5:21:35PM =
[ATesks |

[r

Figure 119. Console Window

2 Insert the VMware server installation CD.
Go to \VMware\RPMS to locate the VMware Tools installation package.

3 Login to the guest operating system from the virtual machine console (see Figure 120).
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[ 172.18.127.11 - vSphere Client .-_JE_L’_(J

File Edit View Inventory Administraton Plug-ns Help

& B ‘(j Home | g Inventory b 3] Inventory

W ulr Bl e Bee e
TE 172.18.127.11 w-b\

& rednats

s [vMA40

{3 windows2003

v8phere Management Assistant 4.8.8
Kernel 2.6.18-128.1.1.el5 on an xB6_b64

liugiong login: wvi-admin
Password:
Last login: Mon Jan 25 88:54:55 on tiyl

Welcome to vMA
run ‘vma-help’ or see htip://www.vmware.com/go/vmad for more details.

[vi-adminBliugiong 1§

Recent Tasks x
Nams | Target | Status | Details | Initisted by | Requested Start Time — | Start Time | Completed Time

[T | v

Figure 120. Console Window — Log In

4  Seclect the template name and then right-click and select Install/Upgrade VMware Tools from the
menu. (sce Figure 118.)

5 Mount the CD with the command:
mount /dev/cdrom /mnt
6 Install the package with the command:

cd /mnt/VMware/RPMS
rpm —Uvh VMware-esx*.1pm

4 NOTE: The package name is likely to be different.
7  Configure the VMware Tools with the command:
vmware-config-tools.pl

8 Enter number: 1
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9  Start the VMware Tools with the command:
vmware-toolbox &

VMware Tools on the summary page displays OK if the tools are available (see Figure 121).

172.18.127.11 - vSphere

i8] xl

File Edit View Inventory Administration Plugdns Help

(=] |Eﬁ Home b g8 Inventory b [El Inventory

mwe @

ol el

B &

[E Tasks |

oo B @ )| @)

= [F 172.18.127.11
{3 rednats
5 [VMA4.0 Performance | Eve:
{3 windows2003 e = =
Guest OS: Red Hat Enterprise Linux 5 (64-bit) o P
VM Version: 4 Consumed Host Memary: 282.00 MB
CPU: 1vCPu Active Guest Memory: 343.00 MB
Memery: 220 Refresh Storage Usage
Memory Overhead:  $4.80 MB Provisioned Storage: i
OK md icates Mware Tools oK Mot-shared Storage: 5.00 GB
TP Addresse: 172.18.127.85 View all Used Storage: 5.00 GB
that VMware DNS Name: livgiong Datastore Capacity | Free | LastUpdat
Tools are State: PBoweradGn & datastorel 63.25GB 4166 GB 1/20/2010
. Host: LIACNSTCESXI0 Llocaldomain < | s
available. Acive Tastes 2
Netwiork Type [
Commands 8 VMNetwork Standard switch network
Shut Down Guest
i Suspend
B Restart Guest
(3 EditSettings
[ Open Console
Annotations
# Edit
Notes: This OVF file contains the vSphere = =l
Recent Tasks x
Name | Target | status | Details | itiated by | Requested Start Ti... = | Start Time | Completed Time -
¥ Powier Onvirtual mach.. (G VMA4.0 & Completed root
¥4 Power Onvirtual mach... F1 redhats & Completed root
#Y _ Bower Nin virtual marh B windows2in: 4 Camrlstad ront 1/20/2010 R=1R=17 AM 1/20/20140 R-1A-19 AM

Figure 121. VMware Tools Available
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VIMA/vMA Shutdown and Startup Configuration

% NOTE: You can configure the physical machine to boot the automatic operating system on startup. This setting
is located in your machine’s basic input/output system (BI0S). For further information, refer to your specific
technical hardware documentation.

% NOTE: You can configure the automatic startup and shutdown properties of guest operating systems as
suspended.

* Automatic Shutdown of guest (VIMA/VMA) when ESXi host is shutting down and
* Automatic Startup of guest (VIMA/vMA) when ESXi host is starting
To configure VIMA/VMA shutdowns and startups:

1 Choose the host server from the left pane tree hierarchy by the Virtual Infrastructure Client
interface and then select the Configuration tab.

2 Seclect Virtual Machine Startup/Shutdown” from the Software list and click Properties. The
Virtual Machine Startup and Shutdown window opens (see Figure 122).
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3 Enter the settings as shown on the Virtual Machine Startup and Shutdown window:

*  For each virtual machine, set delay startup for 10 seconds

*  For cach virtual machine, set delay shutdown for 30 seconds

8.127.11 - vSphere Client
File Edit Vien Inventory Administration Plug-ns Help

~=lBf x|

ﬁ E ‘Eﬁ Home b gf] Inventory b [Ffl Inventory

g &

B @ [17218.127.11
@ redhats
B VMA4.0
(@ windows2003

Hardware

Health Status
Processors
Memary

Storage
Metworking
Storage Adapters
Metwork Adapters
Advanced Settings

Software

Licensed Features
Time Configuration
DNS and Bonting

LIACNSTCESXI01Jocaldomain VMware ESXi, 4.0.0, 164009

| Getting Started Summary  Virtual Machines IResourceAllocation .| Perfformance Configuration Users&Gruups Events

Virtual Machine Startup and Shutdown

Start and Stop Virtual Machines with the system

Default Startup Delay
Default Shutdown Delay

Startup Order
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10 seconds
30 seconds

Permissions

[ Order | Virtual Machine

System Settings

‘ Startup

rtual Machine Startup and Shutdown

¥ Allow virtual machines to start and stop automatically with the system

Default Startup Delay

For each virtual machine, delay startup for:

[m seconds

¥ continue immediately if the VMware Tools start

| Startup Delay | Shutdown | Shutdown Delay|

Default Shutdown Delay
For each virtual machine, delay shutdown for:

[ seconds

Shutdown Action:

Pawer Off

Virtual Machine Startup/Shutdown |

Virtual Machine Swapfile Location
Security Profile

System Resource Allocation

Advanced Settings

Recent Tasks

Name | Target | status

¥Y Power Onvirtual machine & vmado & Compleed
¥Y Power Onvirtual machine G redhats @& Completsd
¥4 Power Onvirtual machine G windows2003 & Completed
¥4 Auto powerOn @ Completed

] Tasks |

e B @ @

Startup Order

Power on the spedified virtual machines when the system starts. During shutdown, they will be stopped in the opposite or

Manual Startup

Order | Virtual Machine | Startup | Startup Delay | Shutdown| Shutdown Delay|
Automatic Startup

1 G windows2003 Enabled  10seconds Shutdo... 30seconds

2 G redhats Enabled  10seconds Shutdo... 30seconds
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Any Order

| ]

(6]

7:36 AM
1/3/2006

Figure 122. Startup/Shutdown Settings
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% NOTE: All hardware elements must have an operational network configuration that allows them to

communicate freely with each other. The Dell UPS Management Software uses TCP and UDP for
communication with UPS.

Confirm that the following UDP ports are enabled on the VIMA/VMA firewall: 161, 162, and 3369
Example commands:

sudo iptables I INPUT pudp dport 161 jACCEPT

sudo iptables I OUTPUT pudp dport 161 jACCEPT

Confirm that the following TCP port is enabled on the VIMA/VMA firewall: 2099

Dell UPS Management Software Installation

To install the software:

1
2

(=]

Start the vMA 4.0 guest operating system.

Download the software from the Dell Web site (support.dell.com) or from the CD (F618R A04 or
higher) provided with the UPS.

Upload the software from Windows to vMA 4.0 using WinSCP tools.

Copy the Linux and InstallerData files from the CD to vMA.

Enter the following commands to access the Linux and InstallerData files:

sudo chmod R 777 Linux

sudo chmod R 777 InstallerData

Enter the Linux path and then enter the following command to install the software:
cd Linux

sudo ./setup_console.bin

Edit the document “VMwareESXHosts” on the installation path.

Add all ESXi server host IP addresses, separated by spaces. Add the IP address of the ESXi server
on which VIMA/VMA is installed as the last entry.

Example: 172.18.127.13 172.18.127.12 172.18.127.11
NOTE: To configure each server, see “vMA Configuration” on page 120.
Start the Agent. From the installation path, enter the command:

sudo ./agent start
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Shutdown Parameter Setting for Network Management Card

The following procedure is an example of entering the settings through the network management card
for a graceful shutdown of selected devices.

ﬁ NOTE: See Table 4 on page 133 for a complete list of Dell Command User Interface (CUI) commands.
1  Go to the installation path.
2 Enter ./CuiManager to start the CuiManager (see Figure 123).

3 Search for a single device by entering search4 and the device network I[P address, or search for
multiple devices within a range.

For example:
search4 —ip 172.18.127.1 —ip 172.18.127.254 —c public
All devices in the network IP address from 172.18.127.1 to 172.18.127.254 are added.

Dell_UPS_Management_Software_Installlog.log

[vi-admin@liugiong ups1$ sudo .- agent start

Starting Agent:

Done

[vi-adminPliugiong ups1$|. CuiManager

CuiManager is starting...

Dell UPS Management Software - only for SNMP Device, wversion: B1.85.8884 Z889-81
-22

Ainy command using option “-help” will show it's messages??

Dell Managerisearchd -ip 172.18.127.1 -ip 172.18.127.254 -c public
Searching SNMP from 172.18.127.1 to 172.18.127.254

Start Searching Thread. ..

Dell MawnagerSearch is Completed, Found 3 UPS, Added 3 UPS

Dell Manager:list

ip

172.18.127.75

172.18.127.24 Powerware BladelUP3

172.18.127 .47 Dell UPS BRack 4Z288W High Efficiency Online HU - 238U
Dell Manager>_

Figure 123. Searching for Devices
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4  Enter the shutdown commands (see Figure 124).
Example:
shutsys ip 172.18.127.47 e true
shutbackup ip 172.18.127.47 e true m 1:00
shutfile e true f/opt/ups/shutdownESXi.sh m 2
listshut —ip 172.18.127.47

NOTE: See "Dell CUI Commands” on page 133 for a description of all Dell CUI commands.

NOTE: Each guest operating system requires a minimum of 30 seconds to run the command file before
shutdown. The -m 1 option in the shutfile command in the example below sets one minute as the total time
allowed to run the command file before shutdown, which allows sufficient time for two guest operating systems.

Example: shutfile -e true -f /opt/ups/shutdownESXi.sh -m 1

[vi-admin@liugiong upslgy| . CuiManager

CuiManager is starting...

Dell UPS Management Software - only for SHMP Device, version: H1.85.0884 ZBA9-81
-22

Any command using option "-help” will show it’s messages?t

Dell Manager>zhutsys -ip 17Z.18.1£7Y.47 -e true

Dell Manager>zhutbackup -ip 172.18.127.47 -e true -m 1:808

Dell Manager>szhutfile -e true -f roptrupsrsshutdownESXi.sh -m 2

Dell Manager>listshut -ip 177.18.127.47

172.18.127.47  Dell UP3 Rack 4288W High Efficiency Online HY - 238U

Allow battery to discharge for Enable A1:88

Shut down when remaining battery time is below Disable BZ:88

Begin Shutdown Immediately if Battery Low Disable

System Enable

Powered by Load Segmentl

Run Command File before Shutdown Enable soptsups/sshutdow
nESXi.sh

Shutdown File Max Execution Time 2 min

Dell Manager>_

Figure 124. Shutdown Parameters
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The host server and guest operating system shut down orderly and gracefully after the battery
discharges for one minute. The status is displayed in the Recent Tasks pane at the bottom of the
window (see Figure 125).

Recent Tasks x

Eme T Target TStatus TDetars | Itiated by | Requested Start M. = | SEart [me |
Initiated guest 05 shutdown B windows2003 @ Completed root 1/25/2010 2 1/25/2010 2:01:37 AM
Initiated guest 05 shutdown G redhats @ Completed root 1/25/2010 2:01:i 125/2010 2:01:07 AM
Shutdown Host E 172.18.127.11 @ Completed vi-admin00 1/25/2010 2:00:! 1/25/2010 2:00:50 AM
Initiated guest 05 shutdown B vMa40 & Completed root 1/25/2010 2:00: 1/25/2010 2:00:41 AM
Auto powerOff @ Completed root 1/25/2010 2:00: 1/25/2010 2:00:41 AM
Shutdown Host E 172.18.127.11 @ Compleed vi-admin00 1/25/2010 2:00:40 AM 1/25/2010 2:00:40 AM 1/25/2010 2:00440 AM
[ Tasks | root

Figure 125. Recent Tasks Pane — Shutdown Confirmation
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Dell CUI Commands List

The Dell Command User Interface (CUI) is a client program that connects to the Dell Monitor Server.
The program operates only on SNMP devices and is used only on operating systems that support
character commands. The Dell CUI is primarily used to search for SNMP devices and to set operating
system shutdown parameters. Table 4 lists the Dell CUI commands.

Table 4. Dell CUlI Commands

Command Description

del Purpose: Delete SNMP device
Format: del target_ip [[target_ip]]
Example: del 172.18.128.32

help Purpose: List all CUI commands
Format: help

import Purpose: Import batch files and execute commands
Format: import target_file

Example: import mybatch.txt

list Purpose: List all SNMP devices connected to monitor

Format: list

listshut Purpose: List shutdown parameter messages
Format: listshut [-ip target_ip]
Option:
-Ip target_ip: IPv4 or IPv6 address
Examples:
listshut -ip 172.18.127.123 (list messages for one device)

listshut (list messages for all devices)

powerby Purpose: Show or Set message of "Powered by"
Format: powerby [-ip target_ip] [-s count]
Options:
-Ip target_ip: IPv4 or IPv6 address
-s count: Segment 1 or 2
Example: powerby -ip 172.18.127.25 -s 1

quit Purpose: Exit CUI

Format: quit
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Command

Description

redundant

Purpose: Show, Add, or Remove IP for "Redundant UPS Input Setting"
Format: redundant [-r] [[target_ip]]

Option:

-T Removes redundant SNMP devices

Examples:

redundant 172.18.128.32 172.18.127.50 (add redundant ip)

redundant -r (remove all redundant ip)

redundant (list all redundant IP messages)

search4

Purpose: Search [Pv4 SNMP devices

Format: search4 [ip target_ip] [-ip target_ip] [-c community]

Options:

-ip target_ip: IPv4 address (default is 255.255.255.255)

-c community SNMP communication authorization (default is public)
Examples:

search4 -ip 172.18.127.1 -ip 172.18.127.254 -¢ public

search4 (using default options value)

search6

Purpose: Search [Pv6 SNMP devices

Format: scarch6 [-ip target_ip] [-c community]

Options:

-Ip target_ip: IPv6 address (default is ff02::1)

-c community SNMP communication authorization (default is public)
Examples:

search6 -ip £02::1 -¢ public

search6 (using default option value)

shutbackup

Purpose: Show or Set message of "Allow battery to discharge for"
Format: Usage: shutbackup [-ip target_ip] [-¢ boolean] [-m time]
Options:

-ip target_ip: IPv4 or IPv6 address

-¢ boolean: true - enable, false - disable

-m time: minute:second (range 0:0 - 999:59)

NOTE No options show relative messages of device.

Example: shutbackup -ip 172.18.127.123 -¢ true -m 10:10
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Command

Description

shutfile

Purpose: Show or Set message of "Run Command File before Shutdown”
Format: shutfile [-e boolean] [-f file] [-m time]

Options:

-e boolean: true - enable, false - disable.

-f target_file: Execute file name before shutdown

-m time: minute: (range 1 - 60)

NOTE No options show relative messages of device.

Example: shutfile -¢ true -f abe.bat -m 2

shutlow

Purpose: Show or Set message of "Begin Shutdown Immediately if Battery Low"

Format: shutlow [-ip target_ip] [-e boolean]
Options:

-ip target_ip: IPv4 or IPv6 address

-e boolean: true - enable, false - disable
NOTE No options show relative messages of device.

Example: shutlow -ip 172.18.127.123 -¢ true

shutremain

Purpose: Show or Set message of "Shut down when remaining battery time is below"

Format: shutremain [-ip target_ip] [-¢ boolean] [-m time]
Options:

-ip target_ip: IPv4 or IPv6 address

-¢ boolean: true - enable, false - disable

-m time: minute:second (range 0:0-999:59)
NOTE No options show relative messages of device.
Example: shutremain -ip 172.18.127.123 -¢ true -m 10:10

shutsys

Purpose: Show or Set message of "System"

Format: shutsys [-ip target_ip] [-e boolean]
Options:

-ip target_ip: IPv4 or IPv6 address.

-¢ boolean: true - enable, false - disable
NOTE No options show relative messages of device.

Example:

stopsearch

Purpose: Stop scarching thread

Format: stopscarch
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